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CAPÍTULO 1

Introdução

Este documento é um tutorial e um guia de referência. Ela não lista todos os possíveis casos de uso, mas dá uma
boa visão geral dos principais recursos.

Starting from 0.9 release, QGIS has optional scripting support using Python language. We’ve decided for Python
as it’s one of the most favourite languages for scripting. PyQGIS bindings depend on SIP and PyQt4. The reason
for using SIP instead of more widely used SWIG is that the whole QGIS code depends on Qt libraries. Python
bindings for Qt (PyQt) are done also using SIP and this allows seamless integration of PyQGIS with PyQt.

A FAZER: Obtendo PyQGIS para o trabalho (compilação Manual, Resolução de Problemas)

Existem várias maneiras de como usar vínculos python QGIS, eles são abordados em detalhes nas seções a seguir:

• emitir comandos no console do Python no QGIS

• criar e utilizar plugins em Python

• criar aplicativos personalizados com base na API do QGIS

There is a complete QGIS API reference that documents the classes from the QGIS libraries. Pythonic QGIS API
is nearly identical to the API in C++.

There are some resources about programming with PyQGIS on QGIS blog. See QGIS tutorial ported to Python for
some examples of simple 3rd party apps. A good resource when dealing with plugins is to download some plugins
from plugin repository and examine their code. Also, the python/plugins/ folder in your QGIS installation
contains some plugin that you can use to learn how to develop such plugin and how to perform some of the most
common tasks

1.1 Terminal Python

For scripting, it is possible to take advantage of integrated Python console. It can be opened from menu: Plugins
→ Python Console. The console opens as a non-modal utility window:

The screenshot above illustrates how to get the layer currently selected in the layer list, show its ID and optionally,
if it is a vector layer, show the feature count. For interaction with QGIS environment, there is a iface variable,
which is an instance of QgsInterface. This interface allows access to the map canvas, menus, toolbars and
other parts of the QGIS application.

For convenience of the user, the following statements are executed when the console is started (in future it will be
possible to set further initial commands)

from qgis.core import *
import qgis.utils

For those which use the console often, it may be useful to set a shortcut for triggering the console (within menu
Settings → Configure shortcuts...)

1
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Figura 1.1: Terminal Python QGIS

1.2 Complementos Python

QGIS allows enhancement of its functionality using plugins. This was originally possible only with C++ language.
With the addition of Python support to QGIS, it is also possible to use plugins written in Python. The main
advantage over C++ plugins is its simplicity of distribution (no compiling for each platform needed) and easier
development.

Many plugins covering various functionality have been written since the introduction of Python support. The plu-
gin installer allows users to easily fetch, upgrade and remove Python plugins. See the Python Plugin Repositories
page for various sources of plugins.

Creating plugins in Python is simple, see Desenvolvimento de Complementos Python for detailed instructions.

1.3 Aplicações Python

Often when processing some GIS data, it is handy to create some scripts for automating the process instead of
doing the same task again and again. With PyQGIS, this is perfectly possible — import the qgis.core module,
initialize it and you are ready for the processing.

Or you may want to create an interactive application that uses some GIS functionality — measure some data,
export a map in PDF or any other functionality. The qgis.gui module additionally brings various GUI compo-
nents, most notably the map canvas widget that can be very easily incorporated into the application with support
for zooming, panning and/or any further custom map tools.

1.3.1 Usando PyQGIS em aplicativo personalizado

Note: do not use qgis.py as a name for your test script — Python will not be able to import the bindings as the
script’s name will shadow them.

First of all you have to import qgis module, set QGIS path where to search for resources — database of projections,
providers etc. When you set prefix path with second argument set as True, QGIS will initialize all paths with
standard dir under the prefix directory. Calling initQgis() function is important to let QGIS search for the
available providers.

from qgis.core import *

2 Capítulo 1. Introdução
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# supply path to where is your qgis installed
QgsApplication.setPrefixPath("/path/to/qgis/installation", True)

# load providers
QgsApplication.initQgis()

Now you can work with QGIS API — load layers and do some processing or fire up a GUI with a map canvas.
The possibilities are endless :-)

When you are done with using QGIS library, call exitQgis() to make sure that everything is cleaned up (e.g.
clear map layer registry and delete layers):

QgsApplication.exitQgis()

1.3.2 Executando aplicativos personalizados

You will need to tell your system where to search for QGIS libraries and appropriate Python modules if they are
not in a well-known location — otherwise Python will complain:

>>> import qgis.core
ImportError: No module named qgis.core

This can be fixed by setting the PYTHONPATH environment variable. In the following commands, qgispath
should be replaced with your actual QGIS installation path:

• no Linux: export PYTHONPATH=/qgispath/share/qgis/python

• no Windows: set PYTHONPATH=c:\qgispath\python

The path to the PyQGIS modules is now known, however they depend on qgis_core and qgis_gui libraries
(the Python modules serve only as wrappers). Path to these libraries is typically unknown for the operating system,
so you get an import error again (the message might vary depending on the system):

>>> import qgis.core
ImportError: libqgis_core.so.1.5.0: cannot open shared object file: No such file or directory

Fix this by adding the directories where the QGIS libraries reside to search path of the dynamic linker:

• no Linux: export LD_LIBRARY_PATH=/qgispath/lib

• no Windows: set PATH=C:\qgispath;%PATH%

These commands can be put into a bootstrap script that will take care of the startup. When deploying custom
applications using PyQGIS, there are usually two possibilities:

• require user to install QGIS on his platform prior to installing your application. The application installer
should look for default locations of QGIS libraries and allow user to set the path if not found. This approach
has the advantage of being simpler, however it requires user to do more steps.

• package QGIS together with your application. Releasing the application may be more challenging and the
package will be larger, but the user will be saved from the burden of downloading and installing additional
pieces of software.

The two deployment models can be mixed - deploy standalone application on Windows and Mac OS X, for Linux
leave the installation of QGIS up to user and his package manager.

1.3. Aplicações Python 3
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CAPÍTULO 2

Carregando Camadas

Vamos abrir algumas camadas com dados. QGIS reconhece camadas vetoriais e matriciais. Adicionalmente,
camadas personalizadas estão disponíveis, mas não discutiremos este tipo de camadas aqui.

2.1 Camadas Vetoriais

Para carregar uma camada vetorial, especifique o identificador da origem de dados, o nome da camada e o nome
do provedor.

layer = QgsVectorLayer(data_source, layer_name, provider_name)
if not layer.isValid():
print "Layer failed to load!"

O identificador da fonte de dados é uma string e é especifico para cada provedor de dados vetoriais. O nome da
camada é usado no painel de lista de camadas. É importante verificar se a camada foi carregada com sucesso. Se
não for, uma instância de camada inválida é retornada.

A lista a seguir mostra como acessar várias fontes de dados usando provedores de dados vetoriais:

• Biblioteca OGR (shapefiles e muitos outros formatos de arquivo) — fonte de dados é o caminho para o
arquivo

vlayer = QgsVectorLayer("/path/to/shapefile/file.shp", "layer_name_you_like", "ogr")

• Banco de dados PostGIS — fonte de dados é uma string com todas as informações necessárias para criar
uma conexão com banco de dados PostgreSQL. : classe class:QgsDataSourceURI pode gerar essa string
para você. Note-se que o QGIS tem de ser compilado com suporte a Postgres, caso contrário, este provedor
não estará disponível.

uri = QgsDataSourceURI()
# set host name, port, database name, username and password
uri.setConnection("localhost", "5432", "dbname", "johny", "xxx")
# set database schema, table name, geometry column and optionally
# subset (WHERE clause)
uri.setDataSource("public", "roads", "the_geom", "cityid = 2643")

vlayer = QgsVectorLayer(uri.uri(), "layer_name_you_like", "postgres")

• CSV ou outros arquivos de texto delimitados — para abrir um arquivo com um ponto e vírgula como
delimitador, com o campo “x” para coordenada x e campo de “y” com coordenada y você usaria algo assim

uri = "/some/path/file.csv?delimiter=%s&xField=%s&yField=%s" % (";", "x", "y")
vlayer = QgsVectorLayer(uri, "layer_name_you_like", "delimitedtext")

Nota: a partir de QGIS versão 1.7 a sequência de provedor está estruturado como uma URL, para que o cam-
inho deve seja prefixado com o arquivo://. Também permite que WKT (texto bem conhecido) geometrias
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formatados como uma alternativa à campos “x” e “y”, e permite que o sistema de referência de coordenadas
a ser especificado. Por exemplo

uri = "file:///some/path/file.csv?delimiter=%s&crs=epsg:4723&wktField=%s" % (";", "shape")

• Arquivos GPX — o provedor de dados “gpx” lê trilhas, rotas e waypoints a partir de arquivos GPX. Para
abrir um arquivo, o tipo (track/route/waypoint) precisa ser especificado como parte da URL

uri = "path/to/gpx/file.gpx?type=track"
vlayer = QgsVectorLayer(uri, "layer_name_you_like", "gpx")

• Banco de dados SpatiaLite — suportado a partir do QGIS v1.1. Da mesma forma que os bancos de dados
PostGIS, QgsDataSourceURI pode ser usada para geração de identificador de fonte de dados

uri = QgsDataSourceURI()
uri.setDatabase(’/home/martin/test-2.3.sqlite’)
schema = ’’
table = ’Towns’
geom_column = ’Geometry’
uri.setDataSource(schema, table, geom_column)

display_name = ’Towns’
vlayer = QgsVectorLayer(uri.uri(), display_name, ’spatialite’)

• Geometrias baseadas em WKB no MySQL, através da OGR — fonte de dados é a string de conexão com a
tabela

uri = "MySQL:dbname,host=localhost,port=3306,user=root,password=xxx|\
layername=my_table"

vlayer = QgsVectorLayer( uri, "my_table", "ogr" )

• Conexão WFS :. a conexão é definida com uma URI e usando o provedor WFS

uri = "http://localhost:8080/geoserver/wfs?srsname=EPSG:23030&typename=union&version=1.0.0&request=GetFeature&service=WFS",
vlayer = QgsVectorLayer("my_wfs_layer", "WFS")

O URI pode ser criado usando a biblioteca urllib padrão.

params = {
’service’: ’WFS’,
’version’: ’1.0.0’,
’request’: ’GetFeature’,
’typename’: ’union’,
’srsname’: "EPSG:23030"

}
uri = ’http://localhost:8080/geoserver/wfs?’ + urllib.unquote(urllib.urlencode(params))

2.2 Camadas Matriciais

Para acessar arquivos matriciais, a biblioteca GDAL é usada. Ela suporta uma ampla gama de formatos de arquivo.
No caso de você ter problemas com a abertura de alguns arquivos, verifique se a sua GDAL tem suporte para o
formato específico (nem todos os formatos estão disponíveis por padrão). Para carregar um raster a partir de um
arquivo, especifique o nome do arquivo e o nome de base

fileName = "/path/to/raster/file.tif"
fileInfo = QFileInfo(fileName)
baseName = fileInfo.baseName()
rlayer = QgsRasterLayer(fileName, baseName)
if not rlayer.isValid():
print "Layer failed to load!"

Camadas matriciais também podem ser criadas a partir de um serviço de WCS.

6 Capítulo 2. Carregando Camadas
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layer_name = ’elevation’
uri = QgsDataSourceURI()
uri.setParam (’url’, ’http://localhost:8080/geoserver/wcs’)
uri.setParam ( "identifier", layer_name)
rlayer = QgsRasterLayer(uri, ’my_wcs_layer’, ’wcs’)

Alternativamente, você pode carregar uma camada a partir de um servidor WMS. No entanto, atualmente, não é
possível acessar resposta GetCapabilities da API — você tem que saber o que você quer camadas

urlWithParams = ’url=http://wms.jpl.nasa.gov/wms.cgi&layers=global_mosaic&styles=pseudo&format=image/jpeg&crs=EPSG:4326’
rlayer = QgsRasterLayer(urlWithParams, ’some layer name’, ’wms’)
if not rlayer.isValid():
print "Layer failed to load!"

2.3 Registro de Camada de Mapa

Se você gostaria de usar as camadas abertas para renderização, não se esqueça de adicioná-los ao registro da
camada de mapa. O registro camada de mapa apropria-se das camadas e podem ser mais tarde acessadas a partir
de qualquer parte do aplicativo pelo seu ID único. Quando a camada é removida do registro camada do mapa, ele
é excluído, também.

Adicionando uma canada ao registro:

QgsMapLayerRegistry.instance().addMapLayer(layer)

Camadas são destruídas automaticamente ao sair, no entanto, se você deseja excluir a camada explicitamente, use

QgsMapLayerRegistry.instance().removeMapLayer(layer_id)

TODO: Mais sobre o registro de camada e mapa?

2.3. Registro de Camada de Mapa 7
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CAPÍTULO 3

Usando Camadas Raster

Esta seção lista várias operações que você pode fazer com camadas raster.

3.1 Detalhes da Camada

A raster layer consists of one or more raster bands - it is referred to as either single band or multi band raster. One
band represents a matrix of values. Usual color image (e.g. aerial photo) is a raster consisting of red, blue and
green band. Single band layers typically represent either continuous variables (e.g. elevation) or discrete variables
(e.g. land use). In some cases, a raster layer comes with a palette and raster values refer to colors stored in the
palette.

>>> rlayer.width(), rlayer.height()
(812, 301)
>>> rlayer.extent()
u’12.095833,48.552777 : 18.863888,51.056944’
>>> rlayer.rasterType()
2 # 0 = GrayOrUndefined (single band), 1 = Palette (single band), 2 = Multiband
>>> rlayer.bandCount()
3
>>> rlayer.metadata()
u’<p class="glossy">Driver:</p>...’
>>> rlayer.hasPyramids()
False

3.2 Estilo Desenhado

When a raster layer is loaded, it gets a default drawing style based on its type. It can be altered either in raster
layer properties or programmatically. The following drawing styles exist:

Índice Constant:
QgsRasterLater.X

Comentário

1 SingleBandGray Single band image drawn as a range of gray colors
2 SingleBandPseudoColor Single band image drawn using a pseudocolor algorithm
3 PalettedColor “Palette” image drawn using color table
4 PalettedSingleBandGray “Palette” layer drawn in gray scale
5 PalettedSingleBandPseu-

doColor
“Palette” layer drawn using a pseudocolor algorithm

7 MultiBandSingleBandGray Layer containing 2 or more bands, but a single band drawn as a range
of gray colors

8 MultiBandSingle-
BandPseudoColor

Layer containing 2 or more bands, but a single band drawn using a
pseudocolor algorithm

9 MultiBandColor Layer containing 2 or more bands, mapped to RGB color space.

9
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To query the current drawing style:

>>> rlayer.drawingStyle()
9

Single band raster layers can be drawn either in gray colors (low values = black, high values = white) or with a
pseudocolor algorithm that assigns colors for values from the single band. Single band rasters with a palette can
be additionally drawn using their palette. Multiband layers are typically drawn by mapping the bands to RGB
colors. Other possibility is to use just one band for gray or pseudocolor drawing.

The following sections explain how to query and modify the layer drawing style. After doing the changes, you
might want to force update of map canvas, see Atualizando camadas.

TODO: contrast enhancements, transparency (no data), user defined min/max, band statistics

3.2.1 Rasters única banda

They are rendered in gray colors by default. To change the drawing style to pseudocolor:

>>> rlayer.setDrawingStyle(QgsRasterLayer.SingleBandPseudoColor)
>>> rlayer.setColorShadingAlgorithm(QgsRasterLayer.PseudoColorShader)

The PseudoColorShader is a basic shader that highlights low values in blue and high values in red. Another,
FreakOutShader uses more fancy colors and according to the documentation, it will frighten your granny and
make your dogs howl.

There is also ColorRampShader which maps the colors as specified by its color map. It has three modes of
interpolation of values:

• linear (INTERPOLATED): resulting color is linearly interpolated from the color map entries above and
below the actual pixel value

• discrete (DISCRETE): color is used from the color map entry with equal or higher value

• exact (EXACT): color is not interpolated, only the pixels with value equal to color map entries are drawn

To set an interpolated color ramp shader ranging from green to yellow color (for pixel values from 0 to 255):

>>> rlayer.setColorShadingAlgorithm(QgsRasterLayer.ColorRampShader)
>>> lst = [ QgsColorRampShader.ColorRampItem(0, QColor(0,255,0)), \

QgsColorRampShader.ColorRampItem(255, QColor(255,255,0)) ]
>>> fcn = rlayer.rasterShader().rasterShaderFunction()
>>> fcn.setColorRampType(QgsColorRampShader.INTERPOLATED)
>>> fcn.setColorRampItemList(lst)

To return back to default gray levels, use:

>>> rlayer.setDrawingStyle(QgsRasterLayer.SingleBandGray)

3.2.2 Rasters Multi Banda

By default, QGIS maps the first three bands to red, green and blue values to create a color image (this is the
MultiBandColor drawing style. In some cases you might want to override these setting. The following code
interchanges red band (1) and green band (2):

>>> rlayer.setGreenBandName(rlayer.bandName(1))
>>> rlayer.setRedBandName(rlayer.bandName(2))

In case only one band is necessary for visualization of the raster, single band drawing can be chosen — either gray
levels or pseudocolor, see previous section:
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>>> rlayer.setDrawingStyle(QgsRasterLayer.MultiBandSingleBandPseudoColor)
>>> rlayer.setGrayBandName(rlayer.bandName(1))
>>> rlayer.setColorShadingAlgorithm(QgsRasterLayer.PseudoColorShader)
>>> # now set the shader

3.3 Atualizando camadas

If you do change layer symbology and would like ensure that the changes are immediately visible to the user, call
these methods:

if hasattr(layer, "setCacheImage"):
layer.setCacheImage(None)

layer.triggerRepaint()

The first call will ensure that the cached image of rendered layer is erased in case render caching is turned on.
This functionality is available from QGIS 1.4, in previous versions this function does not exist — to make sure
that the code works with all versions of QGIS, we first check whether the method exists.

The second call emits signal that will force any map canvas containing the layer to issue a refresh.

With WMS raster layers, these commands do not work. In this case, you have to do it explicitly:

layer.dataProvider().reloadData()
layer.triggerRepaint()

In case you have changed layer symbology (see sections about raster and vector layers on how to do that), you
might want to force QGIS to update the layer symbology in the layer list (legend) widget. This can be done as
follows (iface is an instance of QgisInterface):

iface.legendInterface().refreshLayerSymbology(layer)

3.4 Query Values

To do a query on value of bands of raster layer at some specified point:

ident = rlayer.dataProvider().identify(QgsPoint(15.30,40.98), \
QgsRaster.IdentifyFormatValue)

if ident.isValid():
print ident.results()

The results method in this case returns a dictionary, with band indices as keys, and band values as values.

{1: 17, 2: 220}

3.3. Atualizando camadas 11
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CAPÍTULO 4

Usando Camadas Vetor

Esta seção lista várias operações que podem ser realizadas com camadas vetoriais.

4.1 Interagindo sobre camada vetor

Iterating over the features in a vector layer is one of the most common tasks. Below is an example of the simple
basic code to perform this task and showing some information about each feature. the layer variable is assumed
to have a QgsVectorLayer object

iter = layer.getFeatures()
for feature in iter:

# retrieve every feature with its geometry and attributes
# fetch geometry
geom = feature.geometry()
print "Feature ID %d: " % feature.id()

# show some information about the feature
if geom.type() == QGis.Point:

x = geom.asPoint()
print "Point: " + str(x)

elif geom.type() == QGis.Line:
x = geom.asPolyline()
print "Line: %d points" % len(x)

elif geom.type() == QGis.Polygon:
x = geom.asPolygon()
numPts = 0
for ring in x:
numPts += len(ring)

print "Polygon: %d rings with %d points" % (len(x), numPts)
else:

print "Unknown"

# fetch attributes
attrs = feature.attributes()

# attrs is a list. It contains all the attribute values of this feature
print attrs

Attributes can be referred by index.

idx = layer.fieldNameIndex(’name’)
print feature.attributes()[idx]

13
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4.1.1 Iteração sobre os feições selecionadas

Convenience methods.

For the above cases, and in case you need to consider selection in a vector layer in case it exist, you can use the
features() method from the built-in Processing plugin, as follows:

import processing
features = processing.features(layer)
for feature in features:

# do whatever you need with the feature

Isto afetará todas as feições em uma camada selecionada, ou apenas sobre as feições selecionadas individualmente.

if you only need selected features, you can use the :func: selectedFeatures method from vector layer:

selection = layer.selectedFeatures()
print len(selection)
for feature in selection:

# do whatever you need with the feature

4.1.2 Iterando sobre um subconjunto de feições

Se você quer iterar sobre um conjunto de feições em uma camada, como por exemplo em uma determinada área,
você precisa adicionar um objeto QgsFeatureRequest para a função getFeatures(). Segue um exemplo

request=QgsFeatureRequest()
request.setFilterRect(areaOfInterest)
for f in layer.getFeatures(request):

...

A requisição pode ser usada pra definir os dados retornados para cada feição, de modo que o iterador corra sobre
todas as feições, porém, retorne dados parciais de cada uma delas.

# Only return selected fields
request.setSubsetOfAttributes([0,2])
# More user friendly version
request.setSubsetOfAttributes([’name’,’id’],layer.pendingFields())
# Don’t return geometry objects
request.setFlags(QgsFeatureRequest.NoGeometry)

4.2 Modificando Camadas Vetoriais

Most vector data providers support editing of layer data. Sometimes they support just a subset of possible editing
actions. Use the capabilities() function to find out what set of functionality is supported

caps = layer.dataProvider().capabilities()

Pelo uso do seguinte método para edição de camadas vetoriais, as mudanças são enviadas diretamente para ar-
mazenamento subjacente (um arquivo, um banco de dados, etc). No caso de você preferir mudanças temporárias,
salte para a próxima seção que explica como fazer modifications with editing buffer.

4.2.1 Adicionar feições

Create some QgsFeature instances and pass a list of them to provider’s addFeatures() method. It will
return two values: result (true/false) and list of added features (their ID is set by the data store)
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if caps & QgsVectorDataProvider.AddFeatures:
feat = QgsFeature()
feat.addAttribute(0, ’hello’)
feat.setGeometry(QgsGeometry.fromPoint(QgsPoint(123, 456)))
(res, outFeats) = layer.dataProvider().addFeatures([feat])

4.2.2 Excluir feições

To delete some features, just provide a list of their feature IDs

if caps & QgsVectorDataProvider.DeleteFeatures:
res = layer.dataProvider().deleteFeatures([5, 10])

4.2.3 Modificar Feições

It is possible to either change feature’s geometry or to change some attributes. The following example first changes
values of attributes with index 0 and 1, then it changes the feature’s geometry

fid = 100 # ID of the feature we will modify

if caps & QgsVectorDataProvider.ChangeAttributeValues:
attrs = { 0 : "hello", 1 : 123 }
layer.dataProvider().changeAttributeValues({ fid : attrs })

if caps & QgsVectorDataProvider.ChangeGeometries:
geom = QgsGeometry.fromPoint(QgsPoint(111,222))
layer.dataProvider().changeGeometryValues({ fid : geom })

4.2.4 Adicionando e Removendo Campos

To add fields (attributes), you need to specify a list of field definitions. For deletion of fields just provide a list of
field indexes.

if caps & QgsVectorDataProvider.AddAttributes:
res = layer.dataProvider().addAttributes([QgsField("mytext", QVariant.String), QgsField("myint", QVariant.Int)])

if caps & QgsVectorDataProvider.DeleteAttributes:
res = layer.dataProvider().deleteAttributes([0])

After adding or removing fields in the data provider the layer’s fields need to be updated because the changes are
not automatically propagated.

layer.updateFields()

4.3 Modificando Camadas Vetoriais com um Buffer

Durante a edição de vetores com o QGIS, você precisa primeiramente colocar a camada alvo em modo de edição,
então faça algumas modificações e finalmente envie (ou desfaça) as mudanças. Todas as alterações realizadas até
antes do envio, permanecerão num buffer de edição em memória. É possível usar esta funcionalidade programati-
camente, isso é apenas um outro métodos de edição de vetores que complementam o uso direto de provedores de
dados. Use esta opção quando desenvolvendo alguma ferramenta de interface (GUI) para edição de camadas ve-
toriais, desde que você permita ao usuário decidir enviar/desfazer e desfazer/refazer. Quando enviar as alterações,
toda edição no buffer de edição em memória será salvo em uma provedor de dados.

To find out whether a layer is in editing mode, use isEditing() — the editing functions work only when the
editing mode is turned on. Usage of editing functions
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# add two features (QgsFeature instances)
layer.addFeatures([feat1,feat2])
# delete a feature with specified ID
layer.deleteFeature(fid)

# set new geometry (QgsGeometry instance) for a feature
layer.changeGeometry(fid, geometry)
# update an attribute with given field index (int) to given value (QVariant)
layer.changeAttributeValue(fid, fieldIndex, value)

# add new field
layer.addAttribute(QgsField("mytext", QVariant.String))
# remove a field
layer.deleteAttribute(fieldIndex)

In order to make undo/redo work properly, the above mentioned calls have to be wrapped into undo commands.
(If you do not care about undo/redo and want to have the changes stored immediately, then you will have easier
work by editing with data provider.) How to use the undo functionality

layer.beginEditCommand("Feature triangulation")

# ... call layer’s editing methods ...

if problem_occurred:
layer.destroyEditCommand()
return

# ... more editing ...

layer.endEditCommand()

The beginEditCommand() will create an internal “active” command and will record subsequent changes
in vector layer. With the call to endEditCommand() the command is pushed onto the undo stack and
the user will be able to undo/redo it from GUI. In case something went wrong while doing the changes, the
destroyEditCommand() method will remove the command and rollback all changes done while this com-
mand was active.

Para iniciar o modo de edição, há o método startEditing(), para finalizar a edição há os métodos
commitChanges() e rollback() — porém normalmente você não necessita utilizar estes métodos, ape-
nas deixar estas funcionalidades serem disparadas pelo usuário.

4.4 Using Spatial Index

Spatial indexes can dramatically improve the performance of your code if you need to do frequent queries to a
vector layer. Imagine, for instance, that you are writing an interpolation algorithm, and that for a given location you
need to know the 10 closest points from a points layer, in order to use those point for calculating the interpolated
value. Without a spatial index, the only way for QGIS to find those 10 points is to compute the distance from each
and every point to the specified location and then compare those distances. This can be a very time consuming
task, especially if it needs to be repeated for several locations. If a spatial index exists for the layer, the operation
is much more effective.

Think of a layer without a spatial index as a telephone book in which telephone numbers are not ordered or
indexed. The only way to find the telephone number of a given person is to read from the beginning until you find
it.

Índices espaciais não são criados por padrão para uma camada vetorial do QGIS, mas você pode criá-los facil-
mente. Isto é o que você deve fazer.

1. create spatial index — the following code creates an empty index
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index = QgsSpatialIndex()

2. add features to index — index takes QgsFeature object and adds it to the internal data structure. You can
create the object manually or use one from previous call to provider’s nextFeature()

index.insertFeature(feat)

3. once spatial index is filled with some values, you can do some queries

# returns array of feature IDs of five nearest features
nearest = index.nearestNeighbor(QgsPoint(25.4, 12.7), 5)

# returns array of IDs of features which intersect the rectangle
intersect = index.intersects(QgsRectangle(22.5, 15.3, 23.1, 17.2))

4.5 Writing Vector Layers

Você pode escrever um arquivo de camada vetorial utilizando a classe QgsVectorFileWriter. Ela atende a
qualquer outro tipo de arquivo vetorial com suporte OGR (shapefiles, GeoJSON, KML e outros).

Há duas possibilidades de exportação de camadas vetoriais:

• from an instance of QgsVectorLayer

error = QgsVectorFileWriter.writeAsVectorFormat(layer, "my_shapes.shp", "CP1250", None, "ESRI Shapefile")

if error == QgsVectorFileWriter.NoError:
print "success!"

error = QgsVectorFileWriter.writeAsVectorFormat(layer, "my_json.json", "utf-8", None, "GeoJSON")
if error == QgsVectorFileWriter.NoError:
print "success again!"

O terceiro parâmetro especifica a codificação do texto de saída. Algumas drivers necessitam da operação
correta - shapefiles são alguns destes — porém, caso você não utilize caracteres internacionais você não
precisa se preocupar tanto com codificação. O quarto parâmetro que foi deixado como None pode especi-
ficar o CRS de destino — se uma instância válida da QgsCoordinateReferenceSystem for passada,
a camada será transformada para o CRS informado.

For valid driver names please consult the supported formats by OGR — you should pass the value in
the “Code” column as the driver name. Optionally you can set whether to export only selected features,
pass further driver-specific options for creation or tell the writer not to create attributes — look into the
documentation for full syntax.

• directly from features

# define fields for feature attributes. A list of QgsField objects is needed
fields = [QgsField("first", QVariant.Int),

QgsField("second", QVariant.String)]

# create an instance of vector file writer, which will create the vector file.
# Arguments:
# 1. path to new file (will fail if exists already)
# 2. encoding of the attributes
# 3. field map
# 4. geometry type - from WKBTYPE enum
# 5. layer’s spatial reference (instance of
# QgsCoordinateReferenceSystem) - optional
# 6. driver name for the output file
writer = QgsVectorFileWriter("my_shapes.shp", "CP1250", fields, QGis.WKBPoint, None, "ESRI Shapefile")

if writer.hasError() != QgsVectorFileWriter.NoError:

4.5. Writing Vector Layers 17

http://www.gdal.org/ogr/ogr_formats.html


PyQGIS developer cookbook, Versão 2.6

print "Error when creating shapefile: ", writer.hasError()

# add a feature
fet = QgsFeature()
fet.setGeometry(QgsGeometry.fromPoint(QgsPoint(10,10)))
fet.setAttributes([1, "text"])
writer.addFeature(fet)

# delete the writer to flush features to disk (optional)
del writer

4.6 Memory Provider

O Gerenciador de memória foi desenvolvido para ser utilizado principalmente por plugins ou aplicativos desen-
volvidos por terceiros. Estes não são armazenados no disco, permitindo aos desenvolvedores utilizá-los como um
rápido backend para algumas camadas temporárias.

The provider supports string, int and double fields.

The memory provider also supports spatial indexing, which is enabled by calling the provider’s
createSpatialIndex() function. Once the spatial index is created you will be able to iterate over fea-
tures within smaller regions faster (since it’s not necessary to traverse all the features, only those in specified
rectangle).

A memory provider is created by passing "memory" as the provider string to the QgsVectorLayer construc-
tor.

The constructor also takes a URI defining the geometry type of the layer, one of: "Point", "LineString",
"Polygon", "MultiPoint", "MultiLineString", or "MultiPolygon".

The URI can also specify the coordinate reference system, fields, and indexing of the memory provider in the URI.
The syntax is:

crs=definition Specifies the coordinate reference system, where definition may be any of the forms accepted by
QgsCoordinateReferenceSystem.createFromString()

index=yes Specifies that the provider will use a spatial index

field=name:type(length,precision) Specifies an attribute of the layer. The attribute has a name, and optionally a
type (integer, double, or string), length, and precision. There may be multiple field definitions.

The following example of a URI incorporates all these options

"Point?crs=epsg:4326&field=id:integer&field=name:string(20)&index=yes"

The following example code illustrates creating and populating a memory provider

# create layer
vl = QgsVectorLayer("Point", "temporary_points", "memory")
pr = vl.dataProvider()

# add fields
pr.addAttributes([QgsField("name", QVariant.String),

QgsField("age", QVariant.Int),
QgsField("size", QVariant.Double)])

# add a feature
fet = QgsFeature()
fet.setGeometry(QgsGeometry.fromPoint(QgsPoint(10,10)))
fet.setAttributes(["Johny", 2, 0.3])
pr.addFeatures([fet])

# update layer’s extent when new features have been added
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# because change of extent in provider is not propagated to the layer
vl.updateExtents()

Finally, let’s check whether everything went well

# show some stats
print "fields:", len(pr.fields())
print "features:", pr.featureCount()
e = layer.extent()
print "extent:", e.xMin(),e.yMin(),e.xMax(),e.yMax()

# iterate over features
f = QgsFeature()
features = vl.getFeatures()
for f in features:
print "F:",f.id(), f.attributes(), f.geometry().asPoint()

4.7 Appearance (Symbology) of Vector Layers

When a vector layer is being rendered, the appearance of the data is given by renderer and symbols associated
with the layer. Symbols are classes which take care of drawing of visual representation of features, while renderers
determine what symbol will be used for a particular feature.

The renderer for a given layer can obtained as shown below:

renderer = layer.rendererV2()

And with that reference, let us explore it a bit

print "Type:", rendererV2.type()

There are several known renderer types available in QGIS core library:

Tipo Classes Descrição
singleSymbol QgsSingleSymbolRendererV2 Renders all features with the same symbol
catego-
rizedSymbol

QgsCategorizedSymbolRendererV2Renders features using a different symbol for each
category

graduatedSym-
bol

QgsGraduatedSymbolRendererV2Renders features using a different symbol for each
range of values

There might be also some custom renderer types, so never make an assumption there are just these types. You can
query QgsRendererV2Registry singleton to find out currently available renderers.

It is possible to obtain a dump of a renderer contents in text form — can be useful for debugging

print rendererV2.dump()

4.7.1 Single Symbol Renderer

You can get the symbol used for rendering by calling symbol() method and change it with setSymbol()
method (note for C++ devs: the renderer takes ownership of the symbol.)

4.7.2 Categorized Symbol Renderer

You can query and set attribute name which is used for classification: use classAttribute() and
setClassAttribute() methods.

To get a list of categories
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for cat in rendererV2.categories():
print "%s: %s :: %s" % (cat.value().toString(), cat.label(), str(cat.symbol()))

Where value() is the value used for discrimination between categories, label() is a text used for category
description and symbol() method returns assigned symbol.

The renderer usually stores also original symbol and color ramp which were used for the classification:
sourceColorRamp() and sourceSymbol() methods.

4.7.3 Graduated Symbol Renderer

This renderer is very similar to the categorized symbol renderer described above, but instead of one attribute value
per class it works with ranges of values and thus can be used only with numerical attributes.

To find out more about ranges used in the renderer

for ran in rendererV2.ranges():
print "%f - %f: %s %s" % (

ran.lowerValue(),
ran.upperValue(),
ran.label(),
str(ran.symbol())

)

you can again use classAttribute() to find out classification attribute name, sourceSymbol() and
sourceColorRamp() methods. Additionally there is mode() method which determines how the ranges were
created: using equal intervals, quantiles or some other method.

If you wish to create your own graduated symbol renderer you can do so as illustrated in the example snippet
below (which creates a simple two class arrangement)

from qgis.core import *

myVectorLayer = QgsVectorLayer(myVectorPath, myName, ’ogr’)
myTargetField = ’target_field’
myRangeList = []
myOpacity = 1
# Make our first symbol and range...
myMin = 0.0
myMax = 50.0
myLabel = ’Group 1’
myColour = QtGui.QColor(’#ffee00’)
mySymbol1 = QgsSymbolV2.defaultSymbol(myVectorLayer.geometryType())
mySymbol1.setColor(myColour)
mySymbol1.setAlpha(myOpacity)
myRange1 = QgsRendererRangeV2(myMin, myMax, mySymbol1, myLabel)
myRangeList.append(myRange1)
#now make another symbol and range...
myMin = 50.1
myMax = 100
myLabel = ’Group 2’
myColour = QtGui.QColor(’#00eeff’)
mySymbol2 = QgsSymbolV2.defaultSymbol(

myVectorLayer.geometryType())
mySymbol2.setColor(myColour)
mySymbol2.setAlpha(myOpacity)
myRange2 = QgsRendererRangeV2(myMin, myMax, mySymbol2 myLabel)
myRangeList.append(myRange2)
myRenderer = QgsGraduatedSymbolRendererV2(’’, myRangeList)
myRenderer.setMode(QgsGraduatedSymbolRendererV2.EqualInterval)
myRenderer.setClassAttribute(myTargetField)

20 Capítulo 4. Usando Camadas Vetor



PyQGIS developer cookbook, Versão 2.6

myVectorLayer.setRendererV2(myRenderer)
QgsMapLayerRegistry.instance().addMapLayer(myVectorLayer)

4.7.4 Working with Symbols

For representation of symbols, there is QgsSymbolV2 base class with three derived classes:

• QgsMarkerSymbolV2 — for point features

• QgsLineSymbolV2 — for line features

• QgsFillSymbolV2 — for polygon features

Every symbol consists of one or more symbol layers (classes derived from QgsSymbolLayerV2). The sym-
bol layers do the actual rendering, the symbol class itself serves only as a container for the symbol layers.

Having an instance of a symbol (e.g. from a renderer), it is possible to explore it: type() method says whether
it is a marker, line or fill symbol. There is a dump() method which returns a brief description of the symbol. To
get a list of symbol layers

for i in xrange(symbol.symbolLayerCount()):
lyr = symbol.symbolLayer(i)
print "%d: %s" % (i, lyr.layerType())

To find out symbol’s color use color() method and setColor() to change its color. With marker symbols
additionally you can query for the symbol size and rotation with size() and angle()methods, for line symbols
there is width() method returning line width.

Size and width are in millimeters by default, angles are in degrees.

Working with Symbol Layers

As said before, symbol layers (subclasses of QgsSymbolLayerV2) determine the appearance of the features.
There are several basic symbol layer classes for general use. It is possible to implement new symbol layer types
and thus arbitrarily customize how features will be rendered. The layerType() method uniquely identifies
the symbol layer class — the basic and default ones are SimpleMarker, SimpleLine and SimpleFill symbol layers
types.

You can get a complete list of the types of symbol layers you can create for a given symbol layer class like this

from qgis.core import QgsSymbolLayerV2Registry
myRegistry = QgsSymbolLayerV2Registry.instance()
myMetadata = myRegistry.symbolLayerMetadata("SimpleFill")
for item in myRegistry.symbolLayersForType(QgsSymbolV2.Marker):
print item

Output

EllipseMarker
FontMarker
SimpleMarker
SvgMarker
VectorField

QgsSymbolLayerV2Registry class manages a database of all available symbol layer types.

To access symbol layer data, use its properties() method that returns a key-value dictionary of properties
which determine the appearance. Each symbol layer type has a specific set of properties that it uses. Additionally,
there are generic methods color(), size(), angle(), width() with their setter counterparts. Of course
size and angle is available only for marker symbol layers and width for line symbol layers.
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Creating Custom Symbol Layer Types

Imagine you would like to customize the way how the data gets rendered. You can create your own symbol layer
class that will draw the features exactly as you wish. Here is an example of a marker that draws red circles with
specified radius

class FooSymbolLayer(QgsMarkerSymbolLayerV2):

def __init__(self, radius=4.0):
QgsMarkerSymbolLayerV2.__init__(self)
self.radius = radius
self.color = QColor(255,0,0)

def layerType(self):
return "FooMarker"

def properties(self):
return { "radius" : str(self.radius) }

def startRender(self, context):
pass

def stopRender(self, context):
pass

def renderPoint(self, point, context):
# Rendering depends on whether the symbol is selected (Qgis >= 1.5)
color = context.selectionColor() if context.selected() else self.color
p = context.renderContext().painter()
p.setPen(color)
p.drawEllipse(point, self.radius, self.radius)

def clone(self):
return FooSymbolLayer(self.radius)

The layerType() method determines the name of the symbol layer, it has to be unique among all symbol
layers. Properties are used for persistence of attributes. clone() method must return a copy of the symbol
layer with all attributes being exactly the same. Finally there are rendering methods: startRender() is called
before rendering first feature, stopRender() when rendering is done. And renderPoint() method which
does the rendering. The coordinates of the point(s) are already transformed to the output coordinates.

For polylines and polygons the only difference would be in the rendering method: you would use
renderPolyline() which receives a list of lines, resp. renderPolygon() which receives list of points on
outer ring as a first parameter and a list of inner rings (or None) as a second parameter.

Usually it is convenient to add a GUI for setting attributes of the symbol layer type to allow users to customize the
appearance: in case of our example above we can let user set circle radius. The following code implements such
widget

class FooSymbolLayerWidget(QgsSymbolLayerV2Widget):
def __init__(self, parent=None):
QgsSymbolLayerV2Widget.__init__(self, parent)

self.layer = None

# setup a simple UI
self.label = QLabel("Radius:")
self.spinRadius = QDoubleSpinBox()
self.hbox = QHBoxLayout()
self.hbox.addWidget(self.label)
self.hbox.addWidget(self.spinRadius)
self.setLayout(self.hbox)
self.connect(self.spinRadius, SIGNAL("valueChanged(double)"), \
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self.radiusChanged)

def setSymbolLayer(self, layer):
if layer.layerType() != "FooMarker":

return
self.layer = layer
self.spinRadius.setValue(layer.radius)

def symbolLayer(self):
return self.layer

def radiusChanged(self, value):
self.layer.radius = value
self.emit(SIGNAL("changed()"))

This widget can be embedded into the symbol properties dialog. When the symbol layer type is selected in symbol
properties dialog, it creates an instance of the symbol layer and an instance of the symbol layer widget. Then it
calls setSymbolLayer() method to assign the symbol layer to the widget. In that method the widget should
update the UI to reflect the attributes of the symbol layer. symbolLayer() function is used to retrieve the
symbol layer again by the properties dialog to use it for the symbol.

On every change of attributes, the widget should emit changed() signal to let the properties dialog update the
symbol preview.

Now we are missing only the final glue: to make QGIS aware of these new classes. This is done by adding the
symbol layer to registry. It is possible to use the symbol layer also without adding it to the registry, but some
functionality will not work: e.g. loading of project files with the custom symbol layers or inability to edit the
layer’s attributes in GUI.

We will have to create metadata for the symbol layer

class FooSymbolLayerMetadata(QgsSymbolLayerV2AbstractMetadata):

def __init__(self):
QgsSymbolLayerV2AbstractMetadata.__init__(self, "FooMarker", QgsSymbolV2.Marker)

def createSymbolLayer(self, props):
radius = float(props[QString("radius")]) if QString("radius") in props else 4.0
return FooSymbolLayer(radius)

def createSymbolLayerWidget(self):
return FooSymbolLayerWidget()

QgsSymbolLayerV2Registry.instance().addSymbolLayerType(FooSymbolLayerMetadata())

You should pass layer type (the same as returned by the layer) and symbol type (marker/line/fill) to the con-
structor of parent class. createSymbolLayer() takes care of creating an instance of symbol layer with
attributes specified in the props dictionary. (Beware, the keys are QString instances, not “str” objects). And there
is createSymbolLayerWidget() method which returns settings widget for this symbol layer type.

The last step is to add this symbol layer to the registry — and we are done.

4.7.5 Creating Custom Renderers

It might be useful to create a new renderer implementation if you would like to customize the rules how to select
symbols for rendering of features. Some use cases where you would want to do it: symbol is determined from a
combination of fields, size of symbols changes depending on current scale etc.

The following code shows a simple custom renderer that creates two marker symbols and chooses randomly one
of them for every feature
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import random

class RandomRenderer(QgsFeatureRendererV2):
def __init__(self, syms=None):
QgsFeatureRendererV2.__init__(self, "RandomRenderer")
self.syms = syms if syms else [QgsSymbolV2.defaultSymbol(QGis.Point), QgsSymbolV2.defaultSymbol(QGis.Point)]

def symbolForFeature(self, feature):
return random.choice(self.syms)

def startRender(self, context, vlayer):
for s in self.syms:

s.startRender(context)

def stopRender(self, context):
for s in self.syms:

s.stopRender(context)

def usedAttributes(self):
return []

def clone(self):
return RandomRenderer(self.syms)

The constructor of parent QgsFeatureRendererV2 class needs renderer name (has to be unique among ren-
derers). symbolForFeature() method is the one that decides what symbol will be used for a particular
feature. startRender() and stopRender() take care of initialization/finalization of symbol rendering.
usedAttributes() method can return a list of field names that renderer expects to be present. Finally
clone() function should return a copy of the renderer.

Like with symbol layers, it is possible to attach a GUI for configuration of the renderer. It has to be derived from
QgsRendererV2Widget. The following sample code creates a button that allows user to set symbol of the
first symbol

class RandomRendererWidget(QgsRendererV2Widget):
def __init__(self, layer, style, renderer):
QgsRendererV2Widget.__init__(self, layer, style)
if renderer is None or renderer.type() != "RandomRenderer":

self.r = RandomRenderer()
else:
self.r = renderer

# setup UI
self.btn1 = QgsColorButtonV2("Color 1")
self.btn1.setColor(self.r.syms[0].color())
self.vbox = QVBoxLayout()
self.vbox.addWidget(self.btn1)
self.setLayout(self.vbox)
self.connect(self.btn1, SIGNAL("clicked()"), self.setColor1)

def setColor1(self):
color = QColorDialog.getColor(self.r.syms[0].color(), self)
if not color.isValid(): return
self.r.syms[0].setColor(color);
self.btn1.setColor(self.r.syms[0].color())

def renderer(self):
return self.r

The constructor receives instances of the active layer (QgsVectorLayer), the global style (QgsStyleV2) and
current renderer. If there is no renderer or the renderer has different type, it will be replaced with our new renderer,
otherwise we will use the current renderer (which has already the type we need). The widget contents should be
updated to show current state of the renderer. When the renderer dialog is accepted, widget’s renderer()
method is called to get the current renderer — it will be assigned to the layer.
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The last missing bit is the renderer metadata and registration in registry, otherwise loading of layers with the
renderer will not work and user will not be able to select it from the list of renderers. Let us finish our Random-
Renderer example

class RandomRendererMetadata(QgsRendererV2AbstractMetadata):
def __init__(self):
QgsRendererV2AbstractMetadata.__init__(self, "RandomRenderer", "Random renderer")

def createRenderer(self, element):
return RandomRenderer()

def createRendererWidget(self, layer, style, renderer):
return RandomRendererWidget(layer, style, renderer)

QgsRendererV2Registry.instance().addRenderer(RandomRendererMetadata())

Similarly as with symbol layers, abstract metadata constructor awaits renderer name, name visible for users and
optionally name of renderer’s icon. createRenderer() method passes QDomElement instance that can be
used to restore renderer’s state from DOM tree. createRendererWidget()method creates the configuration
widget. It does not have to be present or can return None if the renderer does not come with GUI.

To associate an icon with the renderer you can assign it in QgsRendererV2AbstractMetadata construc-
tor as a third (optional) argument — the base class constructor in the RandomRendererMetadata __init__()
function becomes

QgsRendererV2AbstractMetadata.__init__(self,
"RandomRenderer",
"Random renderer",
QIcon(QPixmap("RandomRendererIcon.png", "png")))

The icon can be associated also at any later time using setIcon() method of the metadata class. The icon can
be loaded from a file (as shown above) or can be loaded from a Qt resource (PyQt4 includes .qrc compiler for
Python).

4.8 Further Topics

TODO: creating/modifying symbols working with style (QgsStyleV2) working with color ramps
(QgsVectorColorRampV2) rule-based renderer (see this blogpost) exploring symbol layer and renderer
registries
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CAPÍTULO 5

Geometry Handling

Points, linestrings and polygons that represent a spatial feature are commonly referred to as geometries. In QGIS
they are represented with the QgsGeometry class. All possible geometry types are nicely shown in JTS discus-
sion page.

Sometimes one geometry is actually a collection of simple (single-part) geometries. Such a geometry is called
a multi-part geometry. If it contains just one type of simple geometry, we call it multi-point, multi-linestring or
multi-polygon. For example, a country consisting of multiple islands can be represented as a multi-polygon.

As coordenadas de geometrias podem estar em qualquer sistema de referência de coordenadas (SRC). Ao buscar
feições a partir de uma camada, geometrias associadas terão coordenadas no SRC da camada.

5.1 Construção de Geométria

Existem várias opções para criar uma geometria:

• from coordinates

gPnt = QgsGeometry.fromPoint(QgsPoint(1,1))
gLine = QgsGeometry.fromPolyline( [ QgsPoint(1,1), QgsPoint(2,2) ] )
gPolygon = QgsGeometry.fromPolygon( [ [ QgsPoint(1,1), QgsPoint(2,2), QgsPoint(2,1) ] ] )

Coordinates are given using QgsPoint class.

Polyline (Linestring) is represented by a list of points. Polygon is represented by a list of linear rings (i.e.
closed linestrings). First ring is outer ring (boundary), optional subsequent rings are holes in the polygon.

Multi-part geometries go one level further: multi-point is a list of points, multi-linestring is a list of
linestrings and multi-polygon is a list of polygons.

• from well-known text (WKT)

gem = QgsGeometry.fromWkt("POINT (3 4)")

• from well-known binary (WKB)

g = QgsGeometry()
g.setWkbAndOwnership(wkb, len(wkb))

5.2 Access to Geometry

First, you should find out geometry type, wkbType() method is the one to use — it returns a value from
QGis.WkbType enumeration
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>>> gPnt.wkbType() == QGis.WKBPoint
True
>>> gLine.wkbType() == QGis.WKBLineString
True
>>> gPolygon.wkbType() == QGis.WKBPolygon
True
>>> gPolygon.wkbType() == QGis.WKBMultiPolygon
False

As an alternative, one can use type() method which returns a value from QGis.GeometryType enumeration.
There is also a helper function isMultipart() to find out whether a geometry is multipart or not.

To extract information from geometry there are accessor functions for every vector type. How to use accessors

>>> gPnt.asPoint()
(1,1)
>>> gLine.asPolyline()
[(1,1), (2,2)]
>>> gPolygon.asPolygon()
[[(1,1), (2,2), (2,1), (1,1)]]

Note: the tuples (x,y) are not real tuples, they are QgsPoint objects, the values are accessible with x() and y()
methods.

For multipart geometries there are similar accessor functions: asMultiPoint(), asMultiPolyline(),
asMultiPolygon().

5.3 Geometry Predicates and Operations

QGIS uses GEOS library for advanced geometry operations such as geometry predicates (contains(),
intersects(), ...) and set operations (union(), difference(), ...). It can also compute geometric
properties of geometries, such as area (in the case of polygons) or lengths (for polygons and lines)

Here you have a small example that combines iterating over the features in a given layer and performing some
geometric computations based on their geometries.

# we assume that ’layer’ is a polygon layer
features = layer.getFeatures()
for f in features:
geom = f.geometry()
print "Area:", geom.area()
print "Perimeter:", geom.length()

Areas and perimeters don’t take CRS into account when computed using these methods from the QgsGeometry
class. For a more powerful area and distance calculation, the QgsDistanceArea class can be used. If projec-
tions are turned off, calculations will be planar, otherwise they’ll be done on the ellipsoid. When an ellipsoid is
not set explicitly, WGS84 parameters are used for calculations.

d = QgsDistanceArea()
d.setProjectionsEnabled(True)

print "distance in meters: ", d.measureLine(QgsPoint(10,10),QgsPoint(11,11))

You can find many example of algorithms that are included in QGIS and use these methods to analyze and trans-
form vector data. Here are some links to the code of a few of them.

Additional information can be found in followinf sources:

• Geometry transformation: Reproject algorithm

• Distance and area using the QgsDistanceArea class: Distance matrix algorithm

• Multi-part to single-part algorithm
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CAPÍTULO 6

Suporte a projeções

6.1 Sistemas de Referencia de Coordenadas

Os Sistemas de Referencia de Coordenadas (SRC), estão incluídas na classe:Sistema de ReferenciaCoorde-
nadasQgs . Instâncias desta classe podem ser criados de diferentes maneiras:

• specify CRS by its ID

# PostGIS SRID 4326 is allocated for WGS84
crs = QgsCoordinateReferenceSystem(4326, QgsCoordinateReferenceSystem.PostgisCrsId)

O QGIS usa três diferentes ID para cada sistema de referencia:

– PostgisCrsId — IDs used within PostGIS databases.

– InternalCrsId — IDs internally used in QGIS database.

– EpsgCrsId — IDs assigned by the EPSG organization

Se não é determinado uma coisa diferente no segundo parâmetro, o SRID PostGIS será usado por padrão..

• specify CRS by its well-known text (WKT)

wkt = ’GEOGCS["WGS84", DATUM["WGS84", SPHEROID["WGS84", 6378137.0, 298.257223563]],’
PRIMEM["Greenwich", 0.0], UNIT["degree",0.017453292519943295],’
AXIS["Longitude",EAST], AXIS["Latitude",NORTH]]’

crs = QgsCoordinateReferenceSystem(wkt)

• create invalid CRS and then use one of the create*() functions to initialize it. In following example we
use Proj4 string to initialize the projection

crs = QgsCoordinateReferenceSystem()
crs.createFromProj4("+proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs")

É interessante checar se a criação do SRC foi bem sucedida, a função : Évalido() deve retornar o valor
Verdadeiro.

Note that for initialization of spatial reference systems QGIS needs to look up appropriate values in its internal
database srs.db. Thus in case you create an independent application you need to set paths correctly with
QgsApplication.setPrefixPath() otherwise it will fail to find the database. If you are running the
commands from QGIS python console or developing a plugin you do not care: everything is already set up for
you.

Accessing spatial reference system information

print "QGIS CRS ID:", crs.srsid()
print "PostGIS SRID:", crs.srid()
print "EPSG ID:", crs.epsg()
print "Description:", crs.description()
print "Projection Acronym:", crs.projectionAcronym()
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print "Ellipsoid Acronym:", crs.ellipsoidAcronym()
print "Proj4 String:", crs.proj4String()
# check whether it’s geographic or projected coordinate system
print "Is geographic:", crs.geographicFlag()
# check type of map units in this CRS (values defined in QGis::units enum)
print "Map units:", crs.mapUnits()

6.2 Projeções

You can do transformation between different spatial reference systems by using QgsCoordinateTransform
class. The easiest way to use it is to create source and destination CRS and construct
QgsCoordinateTransform instance with them. Then just repeatedly call transform() function
to do the transformation. By default it does forward transformation, but it is capable to do also inverse
transformation

crsSrc = QgsCoordinateReferenceSystem(4326) # WGS 84
crsDest = QgsCoordinateReferenceSystem(32633) # WGS 84 / UTM zone 33N
xform = QgsCoordinateTransform(crsSrc, crsDest)

# forward transformation: src -> dest
pt1 = xform.transform(QgsPoint(18,5))
print "Transformed point:", pt1

# inverse transformation: dest -> src
pt2 = xform.transform(pt1, QgsCoordinateTransform.ReverseTransform)
print "Transformed back:", pt2
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CAPÍTULO 7

Utilizando o Mapa da Tela

O Widget tela Mapa é provavelmente o widget mais importante dentro de QGIS porque mostra o mapa composto
de camadas de mapas sobrepostos e permite a interação com o mapa e camadas. A tela mostra sempre uma parte
do mapa definido pela extensão tela atual. A interação é feita através do uso de ferramentas de mapa existem
ferramentas para panorâmica, zoom, identificando camadas, de medida, de edição de vetores e outros. Semelhante
a outros programas gráficos, há sempre uma ferramenta ativa e que o usuário pode alternar entre as ferramentas
disponíveis.

Na tela o Mapa é implementado como classe: class: QgsMapCanvas em módulo: mod:‘ qgis.gui‘ . A implemen-
tação é baseada no framework Qt Gráficos View. Este quadro geral fornece uma superfície e uma visão na qual os
itens são colocadas gráficos personalizados e usuário pode interagir com eles. Vamos supor que você está bastante
familiarizado com Qt para entender os conceitos de gráficos cena, vista e itens. Se não, por favor, certifique-se de
ler o visão geral do quadro.

Sempre que o mapa foi muito deslocado, zoom in / out (ou alguma outra ação dispara uma atualização), o mapa é
processado novamente dentro da extensão atual. As camadas são prestados a uma imagem (usando: class: classe
QgsMapRenderer) e essa imagem é exibida na tela. O item gráfico (em termos de gráficos vista framework Qt)
responsável por mostrar o mapa é: class: classe QgsMapCanvasMap. Esta classe também controla a atualização
do mapa renderizado. Além disso este item, que atua como um fundo, pode haver mais itens ** mapa de itens na
tela**. Mapa típica itens na tela são elásticos (usados para medir, edição vetor etc.) ou marcadores de vértice. Os
itens de lona são normalmente utilizados para dar algum feedback visual para ferramentas de mapa, por exemplo,
ao criar um novo polígono, a ferramenta de mapa cria um item de canvas elástico que mostra a forma atual do
polígono. Todos os itens de mapa de lona são subclasses de: class: QgsMapCanvasItem que acrescenta mais
algumas funcionalidades para os‘ objetos básicos QGraphicsItem‘.

Para resumir, a arquitetura do mapa na tela são constituídas por três conceitos:

• tela do mapa — para visualização do mapa

• itens na tela do mapa — itens adicionais que podem ser exibidos na tela do mapa

• ferramentas do mapa — para a interagir com o mapa na tela

7.1 Incorporar o Mapa da Tela

Mapa natela é um widget, como qualquer outro widget Qt, então usá-lo é tão simples como criar e mostrá-lo

canvas = QgsMapCanvas()
canvas.show()

Isso produz uma janela independente com o mapa de lona. Ela também pode ser incorporado em um widget ou
janela existente. Ao usar .ui arquivos e Qt Designer, coloque um ‘‘ QWidget‘‘ no formulário e promovê-lo a uma
nova classe: definir ‘‘ QgsMapCanvas‘‘ como nome da classe e definir ‘‘ qgis.gui‘‘ como arquivo de cabeçalho.
O utilitário ‘‘ pyuic4‘‘ vai cuidar dele. Esta é uma maneira muito conveniente de incorporar a tela. A outra
possibilidade é escrever manualmente o código para construir do mapa na tela e outros widgets (como filhos de
uma janela principal ou diálogo) e criar um layout.
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Por padrão, o mapa na tela tem fundo preto e não usa anti-aliasing. Para definir o fundo branco e permitir anti-
aliasing para renderização suave

canvas.setCanvasColor(Qt.white)
canvas.enableAntiAliasing(True)

(Caso você esteja se perguntando, ‘‘ Qt‘‘ vem de ‘‘ módulo PyQt4.QtCore‘‘ e ‘‘ Qt.white‘‘ é um dos pré-definido
‘‘ QColor‘‘ instâncias.)

Agora é hora de adicionar algumas camadas do mapa. Vamos abrir primeiro uma camada e adicioná-lo ao registro
camada do mapa. Então, vamos definir a extensão na tela e definir a lista de camadas na tela

layer = QgsVectorLayer(path, name, provider)
if not layer.isValid():
raise IOError, "Failed to open the layer"

# add layer to the registry
QgsMapLayerRegistry.instance().addMapLayer(layer)

# set extent to the extent of our layer
canvas.setExtent(layer.extent())

# set the map canvas layer set
canvas.setLayerSet( [ QgsMapCanvasLayer(layer) ] )

Depois de executar esses comandos, a tela deve mostrar a camada que você carregou.

7.2 Usando Ferramentas de Mapas na Tela

O exemplo a seguir constrói uma janela que contém um mapa de tela e ferramentas básicas de mapa para o
mapa panorâmica e zoom. Ações são criadas para a ativação de cada ferramenta: panning é feito com: class:
QgsMapToolPan, zoom in / out com um par de: class:‘ QgsMapToolZoom‘ instâncias. As ações são definidas
como verificável e posteriormente atribuído às ferramentas para permitir o tratamento automático das verificados
/ estado desmarcado das ações - quando uma ferramenta de mapa é ativado, a sua ação está marcado como sele-
cionado e a ação da ferramenta mapa anterior é desmarcada. As ferramentas de do mapa são ativados usando o
seguinte método:func: ‘ setMapTool‘.

from qgis.gui import *
from PyQt4.QtGui import QAction, QMainWindow
from PyQt4.QtCore import SIGNAL, Qt, QString

class MyWnd(QMainWindow):
def __init__(self, layer):
QMainWindow.__init__(self)

self.canvas = QgsMapCanvas()
self.canvas.setCanvasColor(Qt.white)

self.canvas.setExtent(layer.extent())
self.canvas.setLayerSet( [ QgsMapCanvasLayer(layer) ] )

self.setCentralWidget(self.canvas)

actionZoomIn = QAction(QString("Zoom in"), self)
actionZoomOut = QAction(QString("Zoom out"), self)
actionPan = QAction(QString("Pan"), self)

actionZoomIn.setCheckable(True)
actionZoomOut.setCheckable(True)
actionPan.setCheckable(True)
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self.connect(actionZoomIn, SIGNAL("triggered()"), self.zoomIn)
self.connect(actionZoomOut, SIGNAL("triggered()"), self.zoomOut)
self.connect(actionPan, SIGNAL("triggered()"), self.pan)

self.toolbar = self.addToolBar("Canvas actions")
self.toolbar.addAction(actionZoomIn)
self.toolbar.addAction(actionZoomOut)
self.toolbar.addAction(actionPan)

# create the map tools
self.toolPan = QgsMapToolPan(self.canvas)
self.toolPan.setAction(actionPan)
self.toolZoomIn = QgsMapToolZoom(self.canvas, False) # false = in
self.toolZoomIn.setAction(actionZoomIn)
self.toolZoomOut = QgsMapToolZoom(self.canvas, True) # true = out
self.toolZoomOut.setAction(actionZoomOut)

self.pan()

def zoomIn(self):
self.canvas.setMapTool(self.toolZoomIn)

def zoomOut(self):
self.canvas.setMapTool(self.toolZoomOut)

def pan(self):
self.canvas.setMapTool(self.toolPan)

Você pode colocar o código acima para um arquivo, por exemplo, ‘‘ mywnd.py‘‘ e experimentá-lo no console do
Python dentro QGIS. Este código irá colocar a camada selecionada atualmente em lona recém-criado

import mywnd
w = mywnd.MyWnd(qgis.utils.iface.activeLayer())
w.show()

Apenas certifique-se de que o arquivo ‘‘ mywnd.py‘‘ está localizado dentro de busca Python caminho (‘‘
sys.path‘‘). Se não for, você pode simplesmente adicioná-lo: ‘‘ sys.path.insert (0, ‘/ minha / path’) ‘‘ — caso
contrário, a declaração de importação irá falhar, não encontrando o módulo.

7.3 Bandas raster e fazedor de vértices

Para mostrar alguns dados adicionais na parte superior do mapa na na tela, use itens de mapa de lona. É possível
criar classes de itens na tela personalizados (cobertos abaixo), no entanto, existem duas classes de itens úteis tela
para conveniência:: class: QgsRubberBand para polylines desenho ou polígonos, e: class:‘ QgsVertexMarker‘
para desenhar pontos. Ambos trabalham com as coordenadas do mapa, assim que a forma é movido / escalados
automaticamente quando a tela está sendo muito deslocado ou ampliada.

Para mostrar as polilinhas

r = QgsRubberBand(canvas, False) # False = not a polygon
points = [ QgsPoint(-1,-1), QgsPoint(0,1), QgsPoint(1,-1) ]
r.setToGeometry(QgsGeometry.fromPolyline(points), None)

Para mostrar o poligono

r = QgsRubberBand(canvas, True) # True = a polygon
points = [ [ QgsPoint(-1,-1), QgsPoint(0,1), QgsPoint(1,-1) ] ]
r.setToGeometry(QgsGeometry.fromPolygon(points), None)

Note-se que aponta para polígono não é uma lista simples: na verdade, é uma lista de anéis contendo anéis lineares
do polígono: primeiro anel é a borda externa, ainda mais (opcional) anéis correspondem aos buracos no polígono.
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As Bandas Raster permitem alguma personalização, ou seja, para mudar sua cor e linha de largura

r.setColor(QColor(0,0,255))
r.setWidth(3)

Os itens em tela são obrigados a cena na tela. Para escondê-los temporariamente (e mostrar mais uma vez, use
a Combinação: hide() and show() Para remover completamente o item, você tem que removê-lo da cena na
tela

canvas.scene().removeItem(r)

(em C ++ é possível simplesmente apagar o item, no entanto, em Python ‘‘ del r‘‘ seria apenas suprimir a referência
eo objeto continuará a existir, uma vez que é de propriedade da tela)

As bandas Rasters também podem serem usadas para desenhar pontos, no entanto a classe : class: class QgsVer-
texMarker é mais adequado para isso (QgsRubberBand só desenhar um retângulo ao redor do ponto desejado).
Como usar o fazedor de Vértices

m = QgsVertexMarker(canvas)
m.setCenter(QgsPoint(0,0))

Isso vai chamar a uma cruz vermelha sobre a posição [0,0]. É possível personalizar o tipo de ícone, tamanho, cor
e espessura da caneta

m.setColor(QColor(0,255,0))
m.setIconSize(5)
m.setIconType(QgsVertexMarker.ICON_BOX) # or ICON_CROSS, ICON_X
m.setPenWidth(3)

Para esconder temporáriamente os marcadores de vértice e removê-los da tela, o mesmo se aplica quanto para as
bandas rasters.

7.4 Desenhar ferramenta de mapa personalizada

Você pode escrever suas ferramentas personalizadas, para implementar um comportamento personalizado às ações
realizadas pelos usuários na tela.

Ferramentas de mapa deve herdar a classe: class: QgsMapTool ou qualquer outra classe derivada, e selecionado
como ferramentas ativas na tela usando o método: func:setMapTool como já vimos.

Aqui está um exemplo de uma ferramenta de mapa que permite definir uma medida retangular, clicando e arras-
tando na tela. Quando o retângulo é definido, ele imprime coordena seu limite no console. Ele utiliza os elementos
de banda de borracha descritos antes para mostrar o retângulo selecionado, uma vez que está a ser definida.

class RectangleMapTool(QgsMapToolEmitPoint):
def __init__(self, canvas):

self.canvas = canvas
QgsMapToolEmitPoint.__init__(self, self.canvas)
self.rubberBand = QgsRubberBand(self.canvas, QGis.Polygon)
self.rubberBand.setColor(Qt.red)
self.rubberBand.setWidth(1)
self.reset()

def reset(self):
self.startPoint = self.endPoint = None
self.isEmittingPoint = False
self.rubberBand.reset(QGis.Polygon)

def canvasPressEvent(self, e):
self.startPoint = self.toMapCoordinates(e.pos())
self.endPoint = self.startPoint
self.isEmittingPoint = True
self.showRect(self.startPoint, self.endPoint)
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def canvasReleaseEvent(self, e):
self.isEmittingPoint = False
r = self.rectangle()
if r is not None:
print "Rectangle:", r.xMin(), r.yMin(), r.xMax(), r.yMax()

def canvasMoveEvent(self, e):
if not self.isEmittingPoint:

return

self.endPoint = self.toMapCoordinates( e.pos() )
self.showRect(self.startPoint, self.endPoint)

def showRect(self, startPoint, endPoint):
self.rubberBand.reset(QGis.Polygon)
if startPoint.x() == endPoint.x() or startPoint.y() == endPoint.y():

return

point1 = QgsPoint(startPoint.x(), startPoint.y())
point2 = QgsPoint(startPoint.x(), endPoint.y())
point3 = QgsPoint(endPoint.x(), endPoint.y())
point4 = QgsPoint(endPoint.x(), startPoint.y())

self.rubberBand.addPoint(point1, False)
self.rubberBand.addPoint(point2, False)
self.rubberBand.addPoint(point3, False)
self.rubberBand.addPoint(point4, True) # true to update canvas
self.rubberBand.show()

def rectangle(self):
if self.startPoint is None or self.endPoint is None:

return None
elif self.startPoint.x() == self.endPoint.x() or self.startPoint.y() == self.endPoint.y():
return None

return QgsRectangle(self.startPoint, self.endPoint)

def deactivate(self):
QgsMapTool.deactivate(self)
self.emit(SIGNAL("deactivated()"))

7.5 Desenhar itens da tela do mapa

TODO: Como criar itens do mapa na tela
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CAPÍTULO 8

Renderização em impressão de mapas

Em geral, há duas abordagens quando os dados de entrada deve ser processado como um mapa: quer fazê-lo
maneira rápida usando: class: QgsMapRenderer ou produzir saída mais afinadas, compondo o mapa na classe de
amigos: class:‘ classe QgsComposition‘.

8.1 Renderização simples

Render some layers using QgsMapRenderer — create destination paint device (QImage, QPainter etc.), set
up layer set, extent, output size and do the rendering

# create image
img = QImage(QSize(800,600), QImage.Format_ARGB32_Premultiplied)

# set image’s background color
color = QColor(255,255,255)
img.fill(color.rgb())

# create painter
p = QPainter()
p.begin(img)
p.setRenderHint(QPainter.Antialiasing)

render = QgsMapRenderer()

# set layer set
lst = [ layer.getLayerID() ] # add ID of every layer
render.setLayerSet(lst)

# set extent
rect = QgsRect(render.fullExtent())
rect.scale(1.1)
render.setExtent(rect)

# set output size
render.setOutputSize(img.size(), img.logicalDpiX())

# do the rendering
render.render(p)

p.end()

# save image
img.save("render.png","png")

37



PyQGIS developer cookbook, Versão 2.6

8.2 Saída usando Compositor de Mapa

Compositor de Mapa é uma ferramenta muito útil se você gostaria de fazer uma produção mais sofisticada do que
a prestação simples mostrado acima. Usando o compositor é possível criar layouts mapa complexas consistindo
de visualizações de mapas, etiquetas, legenda, tabelas e outros elementos que estão normalmente presentes em
mapas de papel. Os layouts podem ser depois exportados para PDF, imagens raster ou diretamente impresso em
uma impressora.

The composer consists of a bunch of classes. They all belong to the core library. QGIS application has a convenient
GUI for placement of the elements, though it is not available in the GUI library. If you are not familiar with Qt
Graphics View framework, then you are encouraged to check the documentation now, because the composer is
based on it.

The central class of the composer is QgsComposition which is derived from QGraphicsScene. Let us
create one

mapRenderer = iface.mapCanvas().mapRenderer()
c = QgsComposition(mapRenderer)
c.setPlotStyle(QgsComposition.Print)

Note-se que a composição leva uma instância de: class: QgsMapRenderer. No código esperamos que estamos ex-
ecutando dentro aplicativo QGIS e, assim, usar o renderizador mapa do mapa de lona. A composição utiliza vários
parâmetros do renderizador mapa, o mais importante o conjunto padrão de camadas de mapas e da extensão atual.
Ao utilizar compositor em um aplicativo independente, você pode criar sua própria instância mapa processador da
mesma forma como mostrado na seção acima e passá-lo para a composição.

É possível adicionar vários elementos (mapa, etiqueta, ...) para a composição — estes elementos têm de ser
descendentes de: class: classe QgsComposerItem. Itens atualmente suportados são:

• map — this item tells the libraries where to put the map itself. Here we create a map and stretch it over the
whole paper size

x, y = 0, 0
w, h = c.paperWidth(), c.paperHeight()
composerMap = QgsComposerMap(c, x,y,w,h)
c.addItem(composerMap)

• label — allows displaying labels. It is possible to modify its font, color, alignment and margin

composerLabel = QgsComposerLabel(c)
composerLabel.setText("Hello world")
composerLabel.adjustSizeToText()
c.addItem(composerLabel)

• legenda

legend = QgsComposerLegend(c)
legend.model().setLayerSet(mapRenderer.layerSet())
c.addItem(legend)

• Barra de Escala:

item = QgsComposerScaleBar(c)
item.setStyle(’Numeric’) # optionally modify the style
item.setComposerMap(composerMap)
item.applyDefaultSize()
c.addItem(item)

• Seta

• Imagem

• Formato

• Tabela
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By default the newly created composer items have zero position (top left corner of the page) and zero size. The
position and size are always measured in millimeters

# set label 1cm from the top and 2cm from the left of the page
composerLabel.setItemPosition(20,10)
# set both label’s position and size (width 10cm, height 3cm)
composerLabel.setItemPosition(20,10, 100, 30)

A frame is drawn around each item by default. How to remove the frame

composerLabel.setFrame(False)

Além de criar os itens compositor à mão, QGIS tem suporte para modelos compositor que são essencialmente
composições com todos os seus itens salvos em um arquivo .qpt (com a sintaxe XML). Infelizmente essa fun-
cionalidade ainda não está disponível na API.

Uma vez que a composição está pronta (os itens do compositor tenham sido criados e adicionados à composição),
podemos prosseguir para produzir um raster e / ou um vetor de saída.

The default output settings for composition are page size A4 and resolution 300 DPI. You can change them if
necessary. The paper size is specified in millimeters

c.setPaperSize(width, height)
c.setPrintResolution(dpi)

8.2.1 Exportando para um arquivo de imagem

The following code fragment shows how to render a composition to a raster image

dpi = c.printResolution()
dpmm = dpi / 25.4
width = int(dpmm * c.paperWidth())
height = int(dpmm * c.paperHeight())

# create output image and initialize it
image = QImage(QSize(width, height), QImage.Format_ARGB32)
image.setDotsPerMeterX(dpmm * 1000)
image.setDotsPerMeterY(dpmm * 1000)
image.fill(0)

# render the composition
imagePainter = QPainter(image)
sourceArea = QRectF(0, 0, c.paperWidth(), c.paperHeight())
targetArea = QRectF(0, 0, width, height)
c.render(imagePainter, targetArea, sourceArea)
imagePainter.end()

image.save("out.png", "png")

8.2.2 Exportando em PDF

The following code fragment renders a composition to a PDF file

printer = QPrinter()
printer.setOutputFormat(QPrinter.PdfFormat)
printer.setOutputFileName("out.pdf")
printer.setPaperSize(QSizeF(c.paperWidth(), c.paperHeight()), QPrinter.Millimeter)
printer.setFullPage(True)
printer.setColorMode(QPrinter.Color)
printer.setResolution(c.printResolution())

pdfPainter = QPainter(printer)
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paperRectMM = printer.pageRect(QPrinter.Millimeter)
paperRectPixel = printer.pageRect(QPrinter.DevicePixel)
c.render(pdfPainter, paperRectPixel, paperRectMM)
pdfPainter.end()
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CAPÍTULO 9

Expressões, filtragem e cálculo dos valores

QGIS oferece alguns recursos para expressões de análise semelhante à SQL. Apenas um pequeno subconjunto de
sintaxe SQL é suportada. As expressões podem ser avaliadas como predicados booleanos (retornando verdadeiro
ou falso) ou como funções (que retornam um valor escalar).

Três tipos básicos são suportados:

• número — ambos os números inteiros e números decimais, por exemplo, 123, 3.14

• texto — eles devem estar entre aspas simples: ‘Olá world’‘

• column reference — when evaluating, the reference is substituted with the actual value of the field. The
names are not escaped.

As seguintes operações estão disponíveis:

• operadores aritméticos: +, -, *, /, ^

• parênteses: para fazer cumprir a precedência do operador: (1 + 1) * 3

• unary plus and minus: -12, +5

• funções matemáticas: sqrt, sen, cos, tan, asen, acos, atan

• funções geométricas: $area, $length

• conversão de funções: para int, para real, para string

E os seguintes predicados são suportados:

• comparação: =, !=, >, >=, <, <=

• pattern matching: LIKE (using % and _), ~ (regular expressions)

• logical predicates: AND, OR, NOT

• NULL value checking: IS NULL, IS NOT NULL

Exemplos de predicados:

• 1 + 2 = 3

• sen(ângulo) > 0

• ’Hello’ LIKE ’He%’

• (x > 10 AND y > 10) OR z = 0

Examples of scalar expressions:

• 2 ^ 10

• sqrt(val)

• $length + 1
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9.1 Parsing Expressions

>>> exp = QgsExpression(’1 + 1 = 2’)
>>> exp.hasParserError()
False
>>> exp = QgsExpression(’1 + 1 = ’)
>>> exp.hasParserError()
True
>>> exp.parserErrorString()
PyQt4.QtCore.QString(u’syntax error, unexpected $end’)

9.2 Evaluating Expressions

9.2.1 Basic Expressions

>>> exp = QgsExpression(’1 + 1 = 2’)
>>> value = exp.evaluate()
>>> value
1

9.2.2 Expressions with features

The following example will evaluate the given expression against a feature. “Column” is the name of the field in
the layer.

>>> exp = QgsExpression(’Column = 99’)
>>> value = exp.evaluate(feature, layer.pendingFields())
>>> bool(value)
True

You can also use QgsExpression.prepare() if you need check more than one feature. Using
QgsExpression.prepare() will increase the speed that evaluate takes to run.

>>> exp = QgsExpression(’Column = 99’)
>>> exp.prepare(layer.pendingFields())
>>> value = exp.evaluate(feature)
>>> bool(value)
True

9.2.3 Handling errors

exp = QgsExpression("1 + 1 = 2 ")
if exp.hasParserError():

raise Expection(exp.parserErrorString())

value = exp.evaluate()
if exp.hasEvalError():

raise ValueError(exp.evalErrorString())

print value

9.3 Examples

The following example can be used to filter a layer and return any feature that matches a predicate.
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def where(layer, exp):
print "Where"
exp = QgsExpression(exp)
if exp.hasParserError():
raise Expection(exp.parserErrorString())

exp.prepare(layer.pendingFields())
for feature in layer.getFeatures():
value = exp.evaluate(feature)
if exp.hasEvalError():

raise ValueError(exp.evalErrorString())
if bool(value):

yield feature

layer = qgis.utils.iface.activeLayer()
for f in where(layer, ’Test > 1.0’):
print f + " Matches expression"
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CAPÍTULO 10

Leitura e Armazenamento de Configurações

Muitas vezes é útil para o plugin salvar algumas variáveis para que o utilizador não necessite introduzir ou sele-
cionar outra vez numa próxima vez que o plugin for acionado.

Estas variáveis podem ser guardadas ou recuperadas com ajuda do Qt e com a API do QGIS. Para cada variável,
deve-se escolher uma chave que irá ser usada para acessar a variável. — para cor favorita de utilizador pode usar
“favourite_color” ou qualquer outra string com significado. É recomendado dar alguma estrutura nos nomes das
chaves.

Nós podemos diferenciar os diversos tipos de configurações:

• global settings — they are bound to the user at particular machine. QGIS itself stores a lot of global settings,
for example, main window size or default snapping tolerance. This functionality is provided directly by Qt
framework by the means of QSettings class. By default, this class stores settings in system’s “native” way
of storing settings, that is — registry (on Windows), .plist file (on Mac OS X) or .ini file (on Unix). The
QSettings documentation is comprehensive, so we will provide just a simple example

def store():
s = QSettings()
s.setValue("myplugin/mytext", "hello world")
s.setValue("myplugin/myint", 10)
s.setValue("myplugin/myreal", 3.14)

def read():
s = QSettings()
mytext = s.value("myplugin/mytext", "default text")
myint = s.value("myplugin/myint", 123)
myreal = s.value("myplugin/myreal", 2.71)

O segundo parâmetro do método value() é opcional e especifica o valor padrão se não for fornecido uma
definição do valor prévio para o nome da configuração passada.

• project settings — vary between different projects and therefore they are connected with a project file.
Map canvas background color or destination coordinate reference system (CRS) are examples — white
background and WGS84 might be suitable for one project, while yellow background and UTM projection
are better for another one. An example of usage follows

proj = QgsProject.instance()

# store values
proj.writeEntry("myplugin", "mytext", "hello world")
proj.writeEntry("myplugin", "myint", 10)
proj.writeEntry("myplugin", "mydouble", 0.01)
proj.writeEntry("myplugin", "mybool", True)

# read values
mytext = proj.readEntry("myplugin", "mytext", "default text")[0]
myint = proj.readNumEntry("myplugin", "myint", 123)[0]
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Como pode ver, o método writeEntry() é usado para todos os tipos de dados, mas em diversos métodos
existe para leitura um valor de configuração de retorno, e o correspondente tem de ser selecionado para cada
tipo de dado.

• map layer settings — these settings are related to a particular instance of a map layer with a project. They
are not connected with underlying data source of a layer, so if you create two map layer instances of one
shapefile, they will not share the settings. The settings are stored in project file, so if the user opens the
project again, the layer-related settings will be there again. This functionality has been added in QGIS v1.4.
The API is similar to QSettings — it takes and returns QVariant instances

# save a value
layer.setCustomProperty("mytext", "hello world")

# read the value again
mytext = layer.customProperty("mytext", "default text")
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CAPÍTULO 11

Comunicação com o usuário

Esta seção mostra alguns métodos e elementos que devem ser usados para se comunicar com o usuário, a fim de
manter a consistência na interface do usuário.

11.1 Showing messages. The QgsMessageBar class

Using message boxes can be a bad idea from a user experience point of view. For showing a small info line or a
warning/error messages, the QGIS message bar is usually a better option.

Using the reference to the QGIS interface object, you can show a message in the message bar with the following
code

iface.messageBar().pushMessage("Error", "I’m sorry Dave, I’m afraid I can’t do that", level=QgsMessageBar.CRITICAL)

Figura 11.1: Barra de mensagem do QGIS

You can set a duration to show it for a limited time

iface.messageBar().pushMessage("Error", ""Ooops, the plugin is not working as it should", level=QgsMessageBar.CRITICAL, duration=3)

Figura 11.2: Barra de Mensagem QGIS como temporizar

The examples above show an error bar, but the level parameter can be used to creating warning messages or
info messages, using the QgsMessageBar.WARNING and QgsMessageBar.INFO constants respectively.

Widgets podem ser adicionados à barra de mensagens, como por exemplo, um botão para mostrar mais infor-
mações

def showError():
pass

widget = iface.messageBar().createMessage("Missing Layers", "Show Me")
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Figura 11.3: Barra de mensagens QGIS (informação)

button = QPushButton(widget)
button.setText("Show Me")
button.pressed.connect(showError)
widget.layout().addWidget(button)
iface.messageBar().pushWidget(widget, QgsMessageBar.WARNING)

Figura 11.4: Barra de mensagens QGIS com um botão

You can even use a message bar in your own dialog so you don’t have to show a message box, or if it doesn’t make
sense to show it in the main QGIS window

class MyDialog(QDialog):
def __init__(self):

QDialog.__init__(self)
self.bar = QgsMessageBar()
self.bar.setSizePolicy( QSizePolicy.Minimum, QSizePolicy.Fixed )
self.setLayout(QGridLayout())
self.layout().setContentsMargins(0,0,0,0)
self.buttonbox = QDialogButtonBox(QDialogButtonBox.Ok)
self.buttonbox.accepted.connect(self.run)
self.layout().addWidget(self.buttonbox , 0,0,2,1)
self.layout().addWidget(self.bar, 0,0,1,1)

def run(self):
self.bar.pushMessage("Hello", "World", level=QgsMessageBar.INFO)

11.2 Mostrando progresso

As barras de progresso também pode ser colocado na barra de mensagem QGIS, uma vez que, como vimos, ele
aceita widgets. Aqui está um exemplo que você pode tentar no console.

import time
from PyQt4.QtGui import QProgressBar
from PyQt4.QtCore import *
progressMessageBar = iface.messageBar().createMessage("Doing something boring...")
progress = QProgressBar()
progress.setMaximum(10)
progress.setAlignment(Qt.AlignLeft|Qt.AlignVCenter)
progressMessageBar.layout().addWidget(progress)
iface.messageBar().pushWidget(progressMessageBar, iface.messageBar().INFO)
for i in range(10):

time.sleep(1)
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Figura 11.5: Barra de mensagens QGIS em diálogo personalizado

progress.setValue(i + 1)
iface.messageBar().clearWidgets()

Also, you can use the built-in status bar to report progress, as in the next example

count = layers.featureCount()
for i, feature in enumerate(features):

#do something time-consuming here
...
percent = i / float(count) * 100
iface.mainWindow().statusBar().showMessage("Processed {} %".format(int(percent)))

iface.mainWindow().statusBar().clearMessage()

11.3 Carregando

Você pode usar o sistema de registro de QGIS para registrar todas as informações que você deseja salvar sobre a
execução de seu código.

QgsMessageLog.logMessage("Your plugin code has been executed correctly", QgsMessageLog.INFO)
QgsMessageLog.logMessage("Your plugin code might have some problems", QgsMessageLog.WARNING)
QgsMessageLog.logMessage("Your plugin code has crashed!", QgsMessageLog.CRITICAL)
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CAPÍTULO 12

Desenvolvimento de Complementos Python

It is possible to create plugins in Python programming language. In comparison with classical plugins written in
C++ these should be easier to write, understand, maintain and distribute due the dynamic nature of the Python
language.

Python plugins are listed together with C++ plugins in QGIS plugin manager. They are searched for in these paths:

• UNIX/Mac: ~/.qgis/python/plugins e (qgis_prefix)/share/qgis/python/plugins

• Windows: ~/.qgis/python/plugins e (qgis_prefix)/python/plugins

Home directory (denoted by above ~) on Windows is usually something like C:\Documents and
Settings\(user) (on Windows XP or earlier) or C:\Users\(user). Since Quantum GIS is using Python
2.7, subdirectories of these paths have to contain an __init__.py file to be considered Python packages that can be
imported as plugins.

Passos:

1. Idea: Have an idea about what you want to do with your new QGIS plugin. Why do you do it? What
problem do you want to solve? Is there already another plugin for that problem?

2. Create files: Create the files described next. A starting point (__init__.py). Fill in the Plugin metadata
(metadata.txt) A main python plugin body (mainplugin.py). A form in QT-Designer (form.ui),
with its resources.qrc.

3. Write code: Write the code inside the mainplugin.py

4. Test: Close and re-open QGIS and import your plugin again. Check if everything is OK.

5. Publish: Publish your plugin in QGIS repository or make your own repository as an “arsenal” of personal
“GIS weapons”.

12.1 Escrevendo um complemento

Since the introduction of Python plugins in QGIS, a number of plugins have appeared - on Plugin Repositories
wiki page you can find some of them, you can use their source to learn more about programming with PyQGIS or
find out whether you are not duplicating development effort. The QGIS team also maintains an Repositório oficial
de complementos python. Ready to create a plugin but no idea what to do? Python Plugin Ideas wiki page lists
wishes from the community!

12.1.1 arquivos de complementos

Here’s the directory structure of our example plugin

PYTHON_PLUGINS_PATH/
MyPlugin/
__init__.py --> *required*
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mainPlugin.py --> *required*
metadata.txt --> *required*
resources.qrc --> *likely useful*
resources.py --> *compiled version, likely useful*
form.ui --> *likely useful*
form.py --> *compiled version, likely useful*

What is the meaning of the files:

• __init__.py = The starting point of the plugin. It has to have the classFactory() method and may
have any other initialisation code.

• mainPlugin.py = The main working code of the plugin. Contains all the information about the actions
of the plugin and the main code.

• resources.qrc = The .xml document created by Qt Designer. Contains relative paths to resources of
the forms.

• resources.py = The translation of the .qrc file described above to Python.

• form.ui = The GUI created by Qt Designer.

• form.py = The translation of the form.ui described above to Python.

• metadata.txt = Required for QGIS >= 1.8.0. Containts general info, version, name and some
other metadata used by plugins website and plugin infrastructure. Since QGIS 2.0 the metadata from
__init__.py are not accepted anymore and the metadata.txt is required.

Here is an online automated way of creating the basic files (skeleton) of a typical QGIS Python plugin.

Also there is a QGIS plugin called Plugin Builder that creates plugin template from QGIS and doesn’t require
internet connection. This is the recommended option, as it produces 2.0 compatible sources.

Aviso: If you plan to upload the plugin to the Repositório oficial de complementos python you must check
that your plugin follows some additional rules, required for plugin Validação

12.2 Conteúdo do complemento

Here you can find information and examples about what to add in each of the files in the file structure described
above.

12.2.1 Plugin metadata

First, plugin manager needs to retrieve some basic information about the plugin such as its name, description etc.
File metadata.txt is the right place to put this information.

Importante: All metadata must be in UTF-8 encoding.

52 Capítulo 12. Desenvolvimento de Complementos Python

http://www.dimitrisk.gr/qgis/creator/
http://geoapt.net/pluginbuilder/


PyQGIS developer cookbook, Versão 2.6

Metadata name re-
querida

Notas

Nome Ver-
dadeiro

a short string containing the name of the plugin

qgisMini-
mumVersion

Ver-
dadeiro

dotted notation of minimum QGIS version

qgisMaxi-
mumVersion

Falso dotted notation of maximum QGIS version

Descrição Ver-
dadeiro

short text which describes the plugin, no HTML allowed

sobre Falso longer text which describes the plugin in details, no HTML allowed
Versão Ver-

dadeiro
short string with the version dotted notation

Autor Ver-
dadeiro

nome do autor

email Ver-
dadeiro

e-mail do autor, não será mostrado no site

changelog Falso string, can be multiline, no HTML allowed
experimental Falso boolean flag, True or False
deprecated Falso boolean flag, True or False, applies to the whole plugin and not just to the

uploaded version
tags Falso comma separated list, spaces are allowed inside individual tags
página inicial Falso a valid URL pointing to the homepage of your plugin
Repositório Falso a valid URL for the source code repository
rastreador Falso a valid URL for tickets and bug reports
Ícone Falso a file name or a relative path (relative to the base folder of the plugin’s

compressed package)
Categoria Falso one of Raster, Vector, Database and Web

By default, plugins are placed in the Plugins menu (we will see in the next section how to add a menu entry for
your plugin) but they can also be placed the into Raster, Vector, Database and Web menus.

A corresponding “category” metadata entry exists to specify that, so the plugin can be classified accordingly. This
metadata entry is used as tip for users and tells them where (in which menu) the plugin can be found. Allowed
values for “category” are: Vector, Raster, Database or Web. For example, if your plugin will be available from
Raster menu, add this to metadata.txt

category=Raster

Nota: If qgisMaximumVersion is empty, it will be automatically set to the major version plus .99 when uploaded
to the Repositório oficial de complementos python.

An example for this metadata.txt

; the next section is mandatory

[general]
name=HelloWorld
email=me@example.com
author=Just Me
qgisMinimumVersion=2.0
description=This is an example plugin for greeting the world.

Multiline is allowed:
lines starting with spaces belong to the same
field, in this case to the "description" field.
HTML formatting is not allowed.

about=This paragraph can contain a detailed description
of the plugin. Multiline is allowed, HTML is not.

version=version 1.2
; end of mandatory metadata
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; start of optional metadata
category=Raster
changelog=The changelog lists the plugin versions

and their changes as in the example below:
1.0 - First stable release
0.9 - All features implemented
0.8 - First testing release

; Tags are in comma separated value format, spaces are allowed within the
; tag name.
; Tags should be in English language. Please also check for existing tags and
; synonyms before creating a new one.
tags=wkt,raster,hello world

; these metadata can be empty, they will eventually become mandatory.
homepage=http://www.itopen.it
tracker=http://bugs.itopen.it
repository=http://www.itopen.it/repo
icon=icon.png

; experimental flag (applies to the single version)
experimental=True

; deprecated flag (applies to the whole plugin and not only to the uploaded version)
deprecated=False

; if empty, it will be automatically set to major version + .99
qgisMaximumVersion=2.0

12.2.2 __init__.py

This file is required by Python’s import system. Also, Quantum GIS requires that this file contains a
classFactory() function, which is called when the plugin gets loaded to QGIS. It receives reference to
instance of QgisInterface and must return instance of your plugin’s class from the mainplugin.py — in
our case it’s called TestPlugin (see below). This is how __init__.py should look like

def classFactory(iface):
from mainPlugin import TestPlugin
return TestPlugin(iface)

## any other initialisation needed

12.2.3 mainPlugin.py

This is where the magic happens and this is how magic looks like: (e.g. mainPlugin.py)

from PyQt4.QtCore import *
from PyQt4.QtGui import *
from qgis.core import *

# initialize Qt resources from file resources.py
import resources

class TestPlugin:

def __init__(self, iface):
# save reference to the QGIS interface
self.iface = iface

def initGui(self):
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# create action that will start plugin configuration
self.action = QAction(QIcon(":/plugins/testplug/icon.png"), "Test plugin", self.iface.mainWindow())
self.action.setObjectName("testAction")
self.action.setWhatsThis("Configuration for test plugin")
self.action.setStatusTip("This is status tip")
QObject.connect(self.action, SIGNAL("triggered()"), self.run)

# add toolbar button and menu item
self.iface.addToolBarIcon(self.action)
self.iface.addPluginToMenu("&Test plugins", self.action)

# connect to signal renderComplete which is emitted when canvas
# rendering is done
QObject.connect(self.iface.mapCanvas(), SIGNAL("renderComplete(QPainter *)"), self.renderTest)

def unload(self):
# remove the plugin menu item and icon
self.iface.removePluginMenu("&Test plugins",self.action)
self.iface.removeToolBarIcon(self.action)

# disconnect form signal of the canvas
QObject.disconnect(self.iface.mapCanvas(), SIGNAL("renderComplete(QPainter *)"), self.renderTest)

def run(self):
# create and show a configuration dialog or something similar
print "TestPlugin: run called!"

def renderTest(self, painter):
# use painter for drawing to map canvas
print "TestPlugin: renderTest called!"

The only plugin functions that must exist in the main plugin source file (e.g. mainPlugin.py) are:

• __init__ –> which gives access to Quantum GIS’ interface

• initGui() –> called when the plugin is loaded

• unload() –> called when the plugin is unloaded

You can see that in the above example, the addPluginToMenu() is used. This will add the corresponding
menu action to the Plugins menu. Alternative methods exist to add the action to a different menu. Here is a list of
those methods:

• addPluginToRasterMenu()

• addPluginToVectorMenu()

• addPluginToDatabaseMenu()

• addPluginToWebMenu()

All of them have the same syntax as the addPluginToMenu() method.

Adding your plugin menu to one of those predefined method is recommended to keep consistency in how plugin
entries are organized. However, you can add your custom menu group directly to the menu bar, as the next example
demonstrates:

def initGui(self):
self.menu = QMenu(self.iface.mainWindow())
self.menu.setObjectName("testMenu")
self.menu.setTitle("MyMenu")

self.action = QAction(QIcon(":/plugins/testplug/icon.png"), "Test plugin", self.iface.mainWindow())
self.action.setObjectName("testAction")
self.action.setWhatsThis("Configuration for test plugin")
self.action.setStatusTip("This is status tip")
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QObject.connect(self.action, SIGNAL("triggered()"), self.run)
self.menu.addAction(self.action)

menuBar = self.iface.mainWindow().menuBar()
menuBar.insertMenu(self.iface.firstRightStandardMenu().menuAction(), self.menu)

def unload(self):
self.menu.deleteLater()

Don’t forget to set QAction and QMenu objectName to a name specific to your plugin so that it can be customized.

12.2.4 Arquivo de Recursos

You can see that in initGui() we’ve used an icon from the resource file (called resources.qrc in our case)

<RCC>
<qresource prefix="/plugins/testplug" >

<file>icon.png</file>
</qresource>

</RCC>

It is good to use a prefix that will not collide with other plugins or any parts of QGIS, otherwise you might get
resources you did not want. Now you just need to generate a Python file that will contain the resources. It’s done
with pyrcc4 command

pyrcc4 -o resources.py resources.qrc

And that’s all... nothing complicated :)

If you’ve done everything correctly you should be able to find and load your plugin in the plugin manager and see
a message in console when toolbar icon or appropriate menu item is selected.

When working on a real plugin it’s wise to write the plugin in another (working) directory and create a makefile
which will generate UI + resource files and install the plugin to your QGIS installation.

12.3 Documentação

The documentation for the plugin can be written as HTML help files. The qgis.utils module provides a
function, showPluginHelp() which will open the help file browser, in the same way as other QGIS help.

The showPluginHelp‘() function looks for help files in the same directory as the calling module. It will
look for, in turn, index-ll_cc.html, index-ll.html, index-en.html, index-en_us.html and
index.html, displaying whichever it finds first. Here ll_cc is the QGIS locale. This allows multiple transla-
tions of the documentation to be included with the plugin.

The showPluginHelp() function can also take parameters packageName, which identifies a specific plugin
for which the help will be displayed, filename, which can replace “index” in the names of files being searched,
and section, which is the name of an html anchor tag in the document on which the browser will be positioned.
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CAPÍTULO 13

IDE settings for writing and debugging plugins

Although each programmer has his preferred IDE/Text editor, here are some recommendations for setting up
popular IDE’s for writing and debugging QGIS Python plugins.

13.1 Uma nota na configuração IDE para Windows

On Linux there is no additional configuration needed to develop plug-ins. But on Windows you need to make sure
you that you have the same environment settings and use the same libraries and interpreter as QGIS. The fastest
way to do this, is to modify the startup batch file of QGIS.

If you used the OSGeo4W Installer, you can find this under the bin folder of your OSGoeW install. Look for
something like C:\OSGeo4W\bin\qgis-unstable.bat.

For using Pyscripter IDE, here’s what you have to do:

• Make a copy of qgis-unstable.bat and rename it pyscripter.bat.

• Open it in an editor. And remove the last line, the one that starts QGIS.

• Add a line that points to the your Pyscripter executable and add the commandline argument that sets the
version of Python to be used (2.7 in the case of QGIS 2.0)

• Also add the argument that points to the folder where Pyscripter can find the Python dll used by QGIS, you
can find this under the bin folder of your OSGeoW install

@echo off
SET OSGEO4W_ROOT=C:\OSGeo4W
call "%OSGEO4W_ROOT%"\bin\o4w_env.bat
call "%OSGEO4W_ROOT%"\bin\gdal16.bat
@echo off
path %PATH%;%GISBASE%\bin
Start C:\pyscripter\pyscripter.exe --python25 --pythondllpath=C:\OSGeo4W\bin

Now when you double click this batch file it will start Pyscripter, with the correct path.

More popular that Pyscripter, Eclipse is a common choice among developers. In the following sections, we will be
explaining how to configure it for developing and testing plugins. To prepare your environment for using Eclipse
in Windows, you should also create a batch file and use it to start Eclipse.

To create that batch file, follow these steps.

• Locate the folder where file:qgis_core.dll resides in. Normally this is C:OSGeo4Wappsqgisbin,
but if you compiled your own QGIS application this is in your build folder in
output/bin/RelWithDebInfo

• Locate your eclipse.exe executable.

• Create the following script and use this to start eclipse when developing QGIS plugins.
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call "C:\OSGeo4W\bin\o4w_env.bat"
set PATH=%PATH%;C:\path\to\your\qgis_core.dll\parent\folder
C:\path\to\your\eclipse.exe

13.2 Debugging using Eclipse and PyDev

13.2.1 Instalação

To use Eclipse, make sure you have installed the following

• Eclipse

• Aptana Eclipse Plugin or PyDev

• QGIS 2.0

13.2.2 Preparing QGIS

There is some preparation to be done on QGIS itself. Two plugins are of interest: Remote Debug and Plugin
reloader.

• Go to Plugins → Fetch python plugins

• Search for Remote Debug ( at the moment it’s still experimental, so enable experimental plugins under the
Options tab in case it does not show up ). Install it.

• Search for Plugin reloader and install it as well. This will let you reload a plugin instead of having to close
and restart QGIS to have the plugin reloaded.

13.2.3 Setting up Eclipse

In Eclipse, create a new project. You can select General Project and link your real sources later on, so it does not
really matter where you place this project.

Now right click your new project and choose New → Folder.

Click [Advanced] and choose Link to alternate location (Linked Folder). In case you already have sources you
want to debug, choose these, in case you don’t, create a folder as it was already explained

Now in the view Project Explorer, your source tree pops up and you can start working with the code. You already
have syntax highlighting and all the other powerful IDE tools available.

13.2.4 Configuring the debugger

To get the debugger working, switch to the Debug perspective in Eclipse (Window → Open Perspective → Other
→ Debug).

Now start the PyDev debug server by choosing PyDev → Start Debug Server.

Eclipse is now waiting for a connection from QGIS to its debug server and when QGIS connects to the debug
server it will allow it to control the python scripts. That’s exactly what we installed the Remote Debug plugin for.
So start QGIS in case you did not already and click the bug symbol .

Now you can set a breakpoint and as soon as the code hits it, execution will stop and you can inspect the current
state of your plugin. (The breakpoint is the green dot in the image below, set one by double clicking in the white
space left to the line you want the breakpoint to be set)

A very interesting thing you can make use of now is the debug console. Make sure that the execution is currently
stopped at a break point, before you proceed.
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Figura 13.1: Eclipse project
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Figura 13.2: Breakpoint

Open the Console view (Window → Show view). It will show the Debug Server console which is not very inter-
esting. But there is a button [Open Console] which lets you change to a more interesting PyDev Debug Console.
Click the arrow next to the [Open Console] button and choose PyDev Console. A window opens up to ask you
which console you want to start. Choose PyDev Debug Console. In case its greyed out and tells you to Start the
debugger and select the valid frame, make sure that you’ve got the remote debugger attached and are currently on
a breakpoint.

Figura 13.3: PyDev Debug Console

You have now an interactive console which let’s you test any commands from within the current context. You can
manipulate variables or make API calls or whatever you like.

A little bit annoying is, that every time you enter a command, the console switches back to the Debug Server. To
stop this behavior, you can click the Pin Console button when on the Debug Server page and it should remember
this decision at least for the current debug session.

13.2.5 Making eclipse understand the API

A very handy feature is to have Eclipse actually know about the QGIS API. This enables it to check your code for
typos. But not only this, it also enables Eclipse to help you with autocompletion from the imports to API calls.

To do this, Eclipse parses the QGIS library files and gets all the information out there. The only thing you have to
do is to tell Eclipse where to find the libraries.

Click Window → Preferences → PyDev → Interpreter → Python.

You will see your configured python interpreter in the upper part of the window (at the moment python2.7 for
QGIS) and some tabs in the lower part. The interesting tabs for us are Libraries and Forced Builtins.

First open the Libraries tab. Add a New Folder and choose the python folder of your QGIS installation. If
you do not know where this folder is (it’s not the plugins folder) open QGIS, start a python console and sim-
ply enter qgis and press Enter. It will show you which QGIS module it uses and its path. Strip the trailing
/qgis/__init__.pyc from this path and you’ve got the path you are looking for.

You should also add your plugins folder here (on Linux it is ~/.qgis/python/plugins).
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Figura 13.4: PyDev Debug Console
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Next jump to the Forced Builtins tab, click on New... and enter qgis. This will make Eclipse parse the QGIS
API. You probably also want eclipse to know about the PyQt4 API. Therefore also add PyQt4 as forced builtin.
That should probably already be present in your libraries tab.

Click OK and you’re done.

Note: every time the QGIS API changes (e.g. if you’re compiling QGIS master and the SIP file changed), you
should go back to this page and simply click Apply. This will let Eclipse parse all the libraries again.

For another possible setting of Eclipse to work with QGIS Python plugins, check this link

13.3 Debugging using PDB

If you do not use an IDE such as Eclipse, you can debug using PDB, following these steps.

First add this code in the spot where you would like to debug

# Use pdb for debugging
import pdb
# These lines allow you to set a breakpoint in the app
pyqtRemoveInputHook()
pdb.set_trace()

Em seguida, execute QGIS a partir da linha de comando.

No Linux fazer:

$ ./Qgis

No Mac OS X fazer:

$ /Applications/Qgis.app/Contents/MacOS/Qgis

And when the application hits your breakpoint you can type in the console!

TODO: Add testing information
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CAPÍTULO 14

Usando Camadas de Plugins

Se o seu plugin usa seus próprios métodos para tornar uma camada de mapa, escrever o seu próprio tipo de camada
com base em QgsPluginLayer pode ser a melhor maneira de implementar isso.

A FAZER: Verifique a exatidão e elabore bons casos de uso para QgsPluginLayer, ...

14.1 Subclasses QgsPluginLayer

Abaixo está um exemplo de uma aplicação mínima QgsPluginLayer. É um trecho do ‘plugin de exemplo
Watermark<http://github.com/sourcepole/qgis-watermark-plugin>‘_:

class WatermarkPluginLayer(QgsPluginLayer):

LAYER_TYPE="watermark"

def __init__(self):
QgsPluginLayer.__init__(self, WatermarkPluginLayer.LAYER_TYPE, "Watermark plugin layer")
self.setValid(True)

def draw(self, rendererContext):
image = QImage("myimage.png")
painter = rendererContext.painter()
painter.save()
painter.drawImage(10, 10, image)
painter.restore()
return True

Os métodos para ler e escrever informações específicas para o arquivo de projeto também podem ser adicionados

def readXml(self, node):
pass

def writeXml(self, node, doc):
pass

Ao carregar um projeto que contém uma tal camada , uma classe de fábrica é necessária

class WatermarkPluginLayerType(QgsPluginLayerType):

def __init__(self):
QgsPluginLayerType.__init__(self, WatermarkPluginLayer.LAYER_TYPE)

def createLayer(self):
return WatermarkPluginLayer()

Você também pode adicionar código para exibir informações personalizadas nas propriedades da camada
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def showLayerProperties(self, layer):
pass
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CAPÍTULO 15

Compatibilidade com versões anteriores do QGIS

15.1 menu Complementos

If you place your plugin menu entries into one of the new menus (Raster, Vector, Database or Web), you should
modify the code of the initGui() and unload() functions. Since these new menus are available only in
QGIS 2.0, the first step is to check that the running QGIS version has all necessary functions. If the new menus
are available, we will place our plugin under this menu, otherwise we will use the old Plugins menu. Here is an
example for Raster menu

def initGui(self):
# create action that will start plugin configuration
self.action = QAction(QIcon(":/plugins/testplug/icon.png"), "Test plugin", self.iface.mainWindow())
self.action.setWhatsThis("Configuration for test plugin")
self.action.setStatusTip("This is status tip")
QObject.connect(self.action, SIGNAL("triggered()"), self.run)

# check if Raster menu available
if hasattr(self.iface, "addPluginToRasterMenu"):
# Raster menu and toolbar available
self.iface.addRasterToolBarIcon(self.action)
self.iface.addPluginToRasterMenu("&Test plugins", self.action)

else:
# there is no Raster menu, place plugin under Plugins menu as usual
self.iface.addToolBarIcon(self.action)
self.iface.addPluginToMenu("&Test plugins", self.action)

# connect to signal renderComplete which is emitted when canvas rendering is done
QObject.connect(self.iface.mapCanvas(), SIGNAL("renderComplete(QPainter *)"), self.renderTest)

def unload(self):
# check if Raster menu available and remove our buttons from appropriate
# menu and toolbar
if hasattr(self.iface, "addPluginToRasterMenu"):
self.iface.removePluginRasterMenu("&Test plugins",self.action)
self.iface.removeRasterToolBarIcon(self.action)

else:
self.iface.removePluginMenu("&Test plugins",self.action)
self.iface.removeToolBarIcon(self.action)

# disconnect from signal of the canvas
QObject.disconnect(self.iface.mapCanvas(), SIGNAL("renderComplete(QPainter *)"), self.renderTest)
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CAPÍTULO 16

Liberando seu complemento

Uma vez que o seu complemento estiver pronto e você achar que o complemento pode ser útil para algumas
pessoas, não hesite em enviá-lo para Repositório oficial de complementos python. Nessa página você pode en-
contrar também pacotes de orientações sobre como preparar o complemento para funcionar bem com o instalador
de complementos. Ou no caso de você gostaria de criar o seu próprio repositório de complementos, criando um
arquivo XML simples que irá listar os complementos e seus metadados, para exemplos, ver outros repositórios de
complementos.

16.1 Repositório oficial de complementos python

Você pode encontrar o repositório oficial de complementos python emt http://plugins.qgis.org/.

Para usar o repositório oficial, deve obter uma ID OSGEO do portal web OSGEO.

Depois de carregado o seu complemento será aprovado por um membro da equipe e você será notificado.

TODO: Insira um link para o documento de governança.

16.1.1 Permissões

Estas regras foram implementadas no repositório oficial de complementos:

• todos os usuários registrados podem adicionar um novo plugin

• A equipe de usuários podem aprovar ou reprovar todas as versões do plugin

• Os usuários que têm permissão especial plugins.can_approve automaticamente têm suas versões de extensão
aprovado

• usuários que têm a permissão especial plugins.can_approve pode aprovar versões carregadas por outros,
enquanto eles estão na lista do proprietários de complementos

• um complemento específico pode ser apagado e editado apenas pela equipe de usuários e pelos proprietários
do complemento

• se um usuário sem permissão plugins.can_approve carrega uma nova versão, a versão do plugin é automati-
camente não aprovado.

16.1.2 Gerenciamento de confiança

Os membros da equipe podem conceder permissão para criadores de complementos selecionado definindo per-
missão plugins.can_approve através da aplicação front-end.

A visão de detalhes do complemento oferece links diretos para conceder permissão para o criador do complemento
ou o proprietários do complemento.

67

http://www.qgis.org/wiki/Python_Plugin_Repositories
http://www.qgis.org/wiki/Python_Plugin_Repositories
http://plugins.qgis.org/
http://www.osgeo.org/osgeo_userid/


PyQGIS developer cookbook, Versão 2.6

16.1.3 Validação

Metadados do complemento são automaticamente importados e validados a partir do pacote compactado quando
o complemento é carregado.

Aqui estão algumas regras de validação que você deve estar ciente quando desejar fazer o upload de um comple-
mento no repositório oficial:

1. o nome da pasta principal que contém o seu complemento deve conter contém apenas caracteres ASCII
(A-Z e a-z), números e caracteres de sublinhado (_) e menos (-), também não pode começar com um dígito

2. metadata.txt é necessário

3. todos metadados requeridos e que devem estar presentes estão listados em metadata table

4. o campo versão metadados deve ser exclusivo

16.1.4 Estrutura dos complementos

Seguindo as regras de validação, o pacote compactado (.zip) de seu plugin deve ter uma estrutura específica
para ser validado como um plugin funcional. Como o plugin será descompactado dentro da pasta de plugins de
usuários ele deve ter seu próprio diretório dentro do arquivo .zip para não interfirir em outros plugins. Arquivos
obrigatórios: metadata.txt e __init__.py. Seria melhor se tivesse um README e também um ícone
representando o plugin (resources.qrc). A seguir, um exemplo de como um plugin.zip deve se parecer.

plugin.zip
pluginfolder/
|-- i18n
| |-- translation_file_de.ts
|-- img
| |-- icon.png
| ‘-- iconsource.svg
|-- __init__.py
|-- Makefile
|-- metadata.txt
|-- more_code.py
|-- main_code.py
|-- README
|-- resources.qrc
|-- resources_rc.py
‘-- ui_Qt_user_interface_file.ui
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CAPÍTULO 17

Fragmentos de código

Esta sección cuenta con fragmentos de código para facilitar el desarrollo de complementos.

17.1 Cómo llamar a un método por un atajo de teclado

In the plug-in add to the initGui()

self.keyAction = QAction("Test Plugin", self.iface.mainWindow())
self.iface.registerMainWindowAction(self.keyAction, "F7") # action1 triggered by F7 key
self.iface.addPluginToMenu("&Test plugins", self.keyAction)
QObject.connect(self.keyAction, SIGNAL("triggered()"),self.keyActionF7)

To unload() add

self.iface.unregisterMainWindowAction(self.keyAction)

The method that is called when F7 is pressed

def keyActionF7(self):
QMessageBox.information(self.iface.mainWindow(),"Ok", "You pressed F7")

17.2 How to toggle Layers

Since QGIS 2.4 there is new layer tree API that allows direct access to the layer tree in the legend. Here is an
example how to toggle visibility of the active layer

root = QgsProject.instance().layerTreeRoot()
node = root.findLayer(iface.activeLayer().id())
new_state = Qt.Checked if node.isVisible()==Qt.Unchecked else Qt.Unchecked
node.setVisible(new_state)

17.3 Cómo acceder a la tabla de atributos de los objetos espa-
ciales seleccionados

def changeValue(self, value):
layer = self.iface.activeLayer()
if(layer):
nF = layer.selectedFeatureCount()
if (nF > 0):
layer.startEditing()
ob = layer.selectedFeaturesIds()
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b = QVariant(value)
if (nF > 1):

for i in ob:
layer.changeAttributeValue(int(i),1,b) # 1 being the second column

else:
layer.changeAttributeValue(int(ob[0]),1,b) # 1 being the second column

layer.commitChanges()
else:

QMessageBox.critical(self.iface.mainWindow(),"Error", "Please select at least one feature from current layer")
else:
QMessageBox.critical(self.iface.mainWindow(),"Error","Please select a layer")

The method requires one parameter (the new value for the attribute field of the selected feature(s)) and can be
called by

self.changeValue(50)
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CAPÍTULO 18

Biblioteca de análise de rede

Starting from revision ee19294562 (QGIS >= 1.8) the new network analysis library was added to the QGIS core
analysis library. The library:

• criar gráfico matemático para dado geográfico (camadas vetor polígono)

• implements basic methods from graph theory (currently only Dijkstra’s algorithm)

The network analysis library was created by exporting basic functions from the RoadGraph core plugin and now
you can use it’s methods in plugins or directly from the Python console.

18.1 Informação Geral

Briefly, a typical use case can be described as:

1. create graph from geodata (usually polyline vector layer)

2. rodar análise gráfica

3. use analysis results (for example, visualize them)

18.2 Building a graph

The first thing you need to do — is to prepare input data, that is to convert a vector layer into a graph. All further
actions will use this graph, not the layer.

As a source we can use any polyline vector layer. Nodes of the polylines become graph vertexes, and segments of
the polylines are graph edges. If several nodes have the same coordinates then they are the same graph vertex. So
two lines that have a common node become connected to each other.

Additionally, during graph creation it is possible to “fix” (“tie”) to the input vector layer any number of additional
points. For each additional point a match will be found — the closest graph vertex or closest graph edge. In the
latter case the edge will be split and a new vertex added.

Vector layer attributes and length of an edge can be used as the properties of an edge.

Converting from a vector layer to the graph is done using the Builder programming pattern. A graph is constructed
using a so-called Director. There is only one Director for now: QgsLineVectorLayerDirector. The director sets
the basic settings that will be used to construct a graph from a line vector layer, used by the builder to create the
graph. Currently, as in the case with the director, only one builder exists: QgsGraphBuilder, that creates QgsGraph
objects. You may want to implement your own builders that will build a graphs compatible with such libraries as
BGL or NetworkX.

To calculate edge properties the programming pattern strategy is used. For now only QgsDistanceArcProperter
strategy is available, that takes into account the length of the route. You can implement your own strategy that
will use all necessary parameters. For example, RoadGraph plugin uses a strategy that computes travel time using
edge length and speed value from attributes.
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It’s time to dive into the process.

First of all, to use this library we should import the networkanalysis module

from qgis.networkanalysis import *

Then some examples for creating a director

# don’t use information about road direction from layer attributes,
# all roads are treated as two-way
director = QgsLineVectorLayerDirector(vLayer, -1, ’’, ’’, ’’, 3)

# use field with index 5 as source of information about road direction.
# one-way roads with direct direction have attribute value "yes",
# one-way roads with reverse direction have the value "1", and accordingly
# bidirectional roads have "no". By default roads are treated as two-way.
# This scheme can be used with OpenStreetMap data
director = QgsLineVectorLayerDirector(vLayer, 5, ’yes’, ’1’, ’no’, 3)

To construct a director we should pass a vector layer, that will be used as the source for the graph structure and
information about allowed movement on each road segment (one-way or bidirectional movement, direct or reverse
direction). The call looks like this

director = QgsLineVectorLayerDirector(vl, directionFieldId,
directDirectionValue,
reverseDirectionValue,
bothDirectionValue,
defaultDirection)

And here is full list of what these parameters mean:

• vl — vector layer used to build the graph

• directionFieldId — index of the attribute table field, where information about roads direction is
stored. If -1, then don’t use this info at all. An integer.

• directDirectionValue — field value for roads with direct direction (moving from first line point to
last one). A string.

• reverseDirectionValue — field value for roads with reverse direction (moving from last line point
to first one). A string.

• bothDirectionValue — field value for bidirectional roads (for such roads we can move from first
point to last and from last to first). A string.

• defaultDirection — default road direction. This value will be used for those roads where field
directionFieldId is not set or has some value different from any of the three values specified above.
An integer. 1 indicates direct direction, 2 indicates reverse direction, and 3 indicates both directions.

It is necessary then to create a strategy for calculating edge properties

properter = QgsDistanceArcProperter()

And tell the director about this strategy

director.addProperter(properter)

Now we can use the builder, which will create the graph. The QgsGraphBuilder class constructor takes several
arguments:

• crs — coordinate reference system to use. Mandatory argument.

• otfEnabled — use “on the fly” reprojection or no. By default const:True (use OTF).

• topologyTolerance — topological tolerance. Default value is 0.

• ellipsoidID — ellipsoid to use. By default “WGS84”.
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# only CRS is set, all other values are defaults
builder = QgsGraphBuilder(myCRS)

Also we can define several points, which will be used in the analysis. For example

startPoint = QgsPoint(82.7112, 55.1672)
endPoint = QgsPoint(83.1879, 54.7079)

Now all is in place so we can build the graph and “tie” these points to it

tiedPoints = director.makeGraph(builder, [startPoint, endPoint])

Building the graph can take some time (which depends on the number of features in a layer and layer size).
tiedPoints is a list with coordinates of “tied” points. When the build operation is finished we can get the
graph and use it for the analysis

graph = builder.graph()

With the next code we can get the vertex indexes of our points

startId = graph.findVertex(tiedPoints[0])
endId = graph.findVertex(tiedPoints[1])

18.3 Graph analysis

Networks analysis is used to find answers to two questions: which vertexes are connected and how to find a
shortest path. To solve these problems the network analysis library provides Dijkstra’s algorithm.

Dijkstra’s algorithm finds the shortest route from one of the vertexes of the graph to all the others and the values
of the optimization parameters. The results can be represented as a shortest path tree.

The shortest path tree is a directed weighted graph (or more precisely — tree) with the following properties:

• only one vertex has no incoming edges — the root of the tree

• all other vertexes have only one incoming edge

• if vertex B is reachable from vertex A, then the path from A to B is the single available path and it is optimal
(shortest) on this graph

To get the shortest path tree use the methods shortestTree() and dijkstra() of QgsGraphAnalyzer class.
It is recommended to use method dijkstra() because it works faster and uses memory more efficiently.

The shortestTree() method is useful when you want to walk around the shortest path tree. It always creates
a new graph object (QgsGraph) and accepts three variables:

• source — input graph

• startVertexIdx — index of the point on the tree (the root of the tree)

• criterionNum — number of edge property to use (started from 0).

tree = QgsGraphAnalyzer.shortestTree(graph, startId, 0)

The dijkstra() method has the same arguments, but returns two arrays. In the first array element i contains
index of the incoming edge or -1 if there are no incoming edges. In the second array element i contains distance
from the root of the tree to vertex i or DOUBLE_MAX if vertex i is unreachable from the root.

(tree, cost) = QgsGraphAnalyzer.dijkstra(graph, startId, 0)

Here is some very simple code to display the shortest path tree using the graph created with the
shortestTree() method (select linestring layer in TOC and replace coordinates with your own). Warn-
ing: use this code only as an example, it creates a lots of QgsRubberBand objects and may be slow on large
data-sets.
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from PyQt4.QtCore import *
from PyQt4.QtGui import *

from qgis.core import *
from qgis.gui import *
from qgis.networkanalysis import *

vl = qgis.utils.iface.mapCanvas().currentLayer()
director = QgsLineVectorLayerDirector(vl, -1, ’’, ’’, ’’, 3)
properter = QgsDistanceArcProperter()
director.addProperter(properter)
crs = qgis.utils.iface.mapCanvas().mapRenderer().destinationCrs()
builder = QgsGraphBuilder(crs)

pStart = QgsPoint(-0.743804, 0.22954)
tiedPoint = director.makeGraph(builder, [pStart])
pStart = tiedPoint[0]

graph = builder.graph()

idStart = graph.findVertex(pStart)

tree = QgsGraphAnalyzer.shortestTree(graph, idStart, 0)

i = 0;
while (i < tree.arcCount()):

rb = QgsRubberBand(qgis.utils.iface.mapCanvas())
rb.setColor (Qt.red)
rb.addPoint (tree.vertex(tree.arc(i).inVertex()).point())
rb.addPoint (tree.vertex(tree.arc(i).outVertex()).point())
i = i + 1

Same thing but using dijkstra() method:

from PyQt4.QtCore import *
from PyQt4.QtGui import *

from qgis.core import *
from qgis.gui import *
from qgis.networkanalysis import *

vl = qgis.utils.iface.mapCanvas().currentLayer()
director = QgsLineVectorLayerDirector(vl, -1, ’’, ’’, ’’, 3)
properter = QgsDistanceArcProperter()
director.addProperter(properter)
crs = qgis.utils.iface.mapCanvas().mapRenderer().destinationCrs()
builder = QgsGraphBuilder(crs)

pStart = QgsPoint(-1.37144, 0.543836)
tiedPoint = director.makeGraph(builder, [pStart])
pStart = tiedPoint[0]

graph = builder.graph()

idStart = graph.findVertex(pStart)

(tree, costs) = QgsGraphAnalyzer.dijkstra(graph, idStart, 0)

for edgeId in tree:
if edgeId == -1:
continue

rb = QgsRubberBand(qgis.utils.iface.mapCanvas())
rb.setColor (Qt.red)
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rb.addPoint (graph.vertex(graph.arc(edgeId).inVertex()).point())
rb.addPoint (graph.vertex(graph.arc(edgeId).outVertex()).point())

18.3.1 Finding shortest paths

To find the optimal path between two points the following approach is used. Both points (start A and end B) are
“tied” to the graph when it is built. Then using the methods shortestTree() or dijkstra() we build the
shortest path tree with root in the start point A. In the same tree we also find the end point B and start to walk
through the tree from point B to point A. The Whole algorithm can be written as

assign = B
while != A

add point to path
get incoming edge for point
look for point , that is start point of this edge
assign =

add point to path

At this point we have the path, in the form of the inverted list of vertexes (vertexes are listed in reversed order
from end point to start point) that will be visited during traveling by this path.

Here is the sample code for QGIS Python Console (you will need to select linestring layer in TOC and replace
coordinates in the code with yours) that uses method shortestTree()

from PyQt4.QtCore import *
from PyQt4.QtGui import *

from qgis.core import *
from qgis.gui import *
from qgis.networkanalysis import *

vl = qgis.utils.iface.mapCanvas().currentLayer()
director = QgsLineVectorLayerDirector(vl, -1, ’’, ’’, ’’, 3)
properter = QgsDistanceArcProperter()
director.addProperter(properter)
crs = qgis.utils.iface.mapCanvas().mapRenderer().destinationCrs()
builder = QgsGraphBuilder(crs)

pStart = QgsPoint(-0.835953, 0.15679)
pStop = QgsPoint(-1.1027, 0.699986)

tiedPoints = director.makeGraph(builder, [pStart, pStop])
graph = builder.graph()

tStart = tiedPoints[0]
tStop = tiedPoints[1]

idStart = graph.findVertex(tStart)
tree = QgsGraphAnalyzer.shortestTree(graph, idStart, 0)

idStart = tree.findVertex(tStart)
idStop = tree.findVertex(tStop)

if idStop == -1:
print "Path not found"

else:
p = []
while (idStart != idStop):
l = tree.vertex(idStop).inArc()
if len(l) == 0:

break
e = tree.arc(l[0])
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p.insert(0, tree.vertex(e.inVertex()).point())
idStop = e.outVertex()

p.insert(0, tStart)
rb = QgsRubberBand(qgis.utils.iface.mapCanvas())
rb.setColor(Qt.red)

for pnt in p:
rb.addPoint(pnt)

And here is the same sample but using dikstra() method

from PyQt4.QtCore import *
from PyQt4.QtGui import *

from qgis.core import *
from qgis.gui import *
from qgis.networkanalysis import *

vl = qgis.utils.iface.mapCanvas().currentLayer()
director = QgsLineVectorLayerDirector(vl, -1, ’’, ’’, ’’, 3)
properter = QgsDistanceArcProperter()
director.addProperter(properter)
crs = qgis.utils.iface.mapCanvas().mapRenderer().destinationCrs()
builder = QgsGraphBuilder(crs)

pStart = QgsPoint(-0.835953, 0.15679)
pStop = QgsPoint(-1.1027, 0.699986)

tiedPoints = director.makeGraph(builder, [pStart, pStop])
graph = builder.graph()

tStart = tiedPoints[0]
tStop = tiedPoints[1]

idStart = graph.findVertex(tStart)
idStop = graph.findVertex(tStop)

(tree, cost) = QgsGraphAnalyzer.dijkstra(graph, idStart, 0)

if tree[idStop] == -1:
print "Path not found"

else:
p = []
curPos = idStop
while curPos != idStart:
p.append(graph.vertex(graph.arc(tree[curPos]).inVertex()).point())
curPos = graph.arc(tree[curPos]).outVertex();

p.append(tStart)

rb = QgsRubberBand(qgis.utils.iface.mapCanvas())
rb.setColor(Qt.red)

for pnt in p:
rb.addPoint(pnt)

18.3.2 Areas of availability

The area of availability for vertex A is the subset of graph vertexes that are accessible from vertex A and the cost
of the paths from A to these vertexes are not greater that some value.
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More clearly this can be shown with the following example: “There is a fire station. Which parts of city can a
fire truck reach in 5 minutes? 10 minutes? 15 minutes?”. Answers to these questions are fire station’s areas of
availability.

To find the areas of availability we can use method dijkstra() of the QgsGraphAnalyzer class. It is
enough to compare the elements of the cost array with a predefined value. If cost[i] is less than or equal to a
predefined value, then vertex i is inside the area of availability, otherwise it is outside.

A more difficult problem is to get the borders of the area of availability. The bottom border is the set of vertexes
that are still accessible, and the top border is the set of vertexes that are not accessible. In fact this is simple: it
is the availability border based on the edges of the shortest path tree for which the source vertex of the edge is
accessible and the target vertex of the edge is not.

Here is an example

from PyQt4.QtCore import *
from PyQt4.QtGui import *

from qgis.core import *
from qgis.gui import *
from qgis.networkanalysis import *

vl = qgis.utils.iface.mapCanvas().currentLayer()
director = QgsLineVectorLayerDirector(vl, -1, ’’, ’’, ’’, 3)
properter = QgsDistanceArcProperter()
director.addProperter(properter)
crs = qgis.utils.iface.mapCanvas().mapRenderer().destinationCrs()
builder = QgsGraphBuilder(crs)

pStart = QgsPoint(65.5462, 57.1509)
delta = qgis.utils.iface.mapCanvas().getCoordinateTransform().mapUnitsPerPixel() * 1

rb = QgsRubberBand(qgis.utils.iface.mapCanvas(), True)
rb.setColor(Qt.green)
rb.addPoint(QgsPoint(pStart.x() - delta, pStart.y() - delta))
rb.addPoint(QgsPoint(pStart.x() + delta, pStart.y() - delta))
rb.addPoint(QgsPoint(pStart.x() + delta, pStart.y() + delta))
rb.addPoint(QgsPoint(pStart.x() - delta, pStart.y() + delta))

tiedPoints = director.makeGraph(builder, [pStart])
graph = builder.graph()
tStart = tiedPoints[0]

idStart = graph.findVertex(tStart)

(tree, cost) = QgsGraphAnalyzer.dijkstra(graph, idStart, 0)

upperBound = []
r = 2000.0
i = 0
while i < len(cost):

if cost[i] > r and tree[i] != -1:
outVertexId = graph.arc(tree [i]).outVertex()
if cost[outVertexId] < r:

upperBound.append(i)
i = i + 1

for i in upperBound:
centerPoint = graph.vertex(i).point()
rb = QgsRubberBand(qgis.utils.iface.mapCanvas(), True)
rb.setColor(Qt.red)
rb.addPoint(QgsPoint(centerPoint.x() - delta, centerPoint.y() - delta))
rb.addPoint(QgsPoint(centerPoint.x() + delta, centerPoint.y() - delta))
rb.addPoint(QgsPoint(centerPoint.x() + delta, centerPoint.y() + delta))
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rb.addPoint(QgsPoint(centerPoint.x() - delta, centerPoint.y() + delta))
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